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INTRODUCTION 
 
SYSCON - System Configurator - is a software tool especially developed to configure, maintain and 
operate the newest SMAR Fieldbus products line, by a Personal Computer with a Fieldbus 
interface. 
 
The friendly Man-Machine Interface (MMI) of the SYSCON provides an efficient and productive 
interaction with the user, without previous knowledge of the software. The use of the Fieldbus 
protocol provides interoperability between the system and each piece of equipment. The physical 
interface with the field network - the PCI (Process Control Interface) Board or the DFI (Fieldbus 
Universal Bridge) - is connected to a PC bus: equipment especially developed by SMAR for its 
Fieldbus line. 
 
SYSCON runs on Microsoft® Windows NT™ Operating System, version 4.0 or later, or Windows 
2000. 
 
This manual refers to the version 6.00 of SYSCON. 
 
 
 
This product is protected by US patent numbers 6,095,674; 5,841,654 and other U.S. Patents 
pending. 
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Section 1 
 

1.1 

1 Getting Started 
 

1.1 System Requirements 

1.1.1 Minimum: 
 
Operational System ⇒ Windows NT 4.0 - Service Pack 6a 
    or Windows 2000 - Service Pack 3 
Processor  ⇒ Pentium 233 MHz 
RAM  ⇒ 64 MB 
Free HDD Space ⇒ 20 MB 
Display  ⇒ 800x600 - 64 KColors 
CD-ROM 
 

1.1.2 Recommended: 
 
Operational System ⇒ Windows NT 4.0 - Service Pack 6a 
    or Windows 2000 - Service Pack 3 
Processor  ⇒ Pentium 350 MHz 
RAM  ⇒ 128 MB 
Free HDD Space ⇒ 20 MB 
Display  ⇒ 1280x1024 - True Color 
CD-ROM 
 
 
 

1.2 Preparing the Installation 
 
It is recommended to uninstall any older versions of SYSCON before installing new versions. 
 
Follow these steps to remove the application: 
 
1. From the Start menu, select Settings - Control Panel. 

2. Double-click the Add/Remove Programs icon. The Add/Remove Programs Properties dialog box 
 will open. 

3. Select the item Syscon from the list of programs. 

4. Click Add/Remove. 

5. Click Yes to confirm that SYSCON is to be removed. 
 

 
Figure 1.1. Confirm File Deletion 

 
6. Wait a few minutes for the uninstall program to indicate that the process is complete. Click Ok. 
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Figure 1.2. Uninstall Completed 

 
 

1.3 Installing SYSCON 
 
Place the SYSTEM302 CD installation at the CD-ROM drive. The Installation dialog box will open 
automatically. 
 
Click the System302 button. 
 
Follow the instructions in the dialog boxes to complete the installation. It will install SYSCON and 
other programs that compound System302, such as Device Support and OLE Server. 
 
To initialize SYSCON click the Windows Start button, at the Task Bar, point the cursor to the item 
Programs, then point it to the item System302. Finally, click the item Syscon, as indicated in the 
next figure: 
 

 
Figure 1.3. Starting SYSCON 

 
At the first time working with SYSCON, the License Information dialog box will appear: 
 

 
Figure 1.4. License Information Dialog Box 
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Run the Get License software, click the Generate FaxBack button and fill in the form. Fax the 
completed FAX-BACK form to SMAR using the Fax number listed on the FaxBack.txt file. SMAR 
will issue the user a License Key to authorize the installed product. 
 
Type the license key in the Syscon License Key box and click the Grant License Keys button. After 
the user finished granting the License Keys, click Exit. 
 
Now, the user can finally start using SYSCON 6.0. 
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Section 2 
 

2.1 

2 Using SYSCON 6.0 
 

2.1 Working with Project Files 

2.1.1 New Project 
 
To create a project file, go to the Project File menu and click New, as the following figure shows: 
 

 
Figure 2.1. Project File Menu: New 

 
The Document Type box will appear. Click the option Project, as indicated below: 
 

 
Figure 2.2. Select the File Type 

 
The New Project dialog box will open: 
 
1. Choose the folder where the project will be saved. 

2. Type the name for the project in the File Name box. 

3. Click Save. If the new project is not to be created, click Cancel. 

 
See the following figure: 
 

 
Figure 2.3. New Project Dialog Box 

 
SYSCON will automatically create a folder with the name the user typed for the project inside the 
folder selected. 
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Shortcuts: 
 
Toolbar:  

 
Since the new project has been created, the Project window will open: 
 

 
Figure 2.4. Project Window 

 

2.1.2 New HSE Project 
 
To create the HSE project file, go to the Project File menu, click New, and select the option HSE 
Project in the Document Type box. See the following figure: 
 

 
Figure 2.5. Select the File Type 

 
The New Project dialog box will open. Choose the folder where the project will be saved and type 
the name for the project. 
 
SYSCON will automatically create the HSE project adding the fieldbus channel and the Foundation 
Fieldbus HSE Host. The Project window will look like the figure below: 
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Figure 2.6. Project Window 

2.1.3 Open 
 
To open an existing project, go to the File menu and click Open, as in the following figure: 
 

 
Figure 2.7. Project File Menu: Open 

 
The Open dialog box will open: 
 
1. In the Look in box, select the folder that contains the project file to be opened. 

2. Click on the project file icon or type its name in the File name box. 

3. Click Open to conclude this task. 

 

 
Figure 2.8. Open Project Dialog Box 
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Shortcuts: 
 
Toolbar:  

 

Checking the version 
Starting from version 5.10, SYSCON verifies if the configuration file was generated by previous or 
later versions. 
 
If the user is trying to open a configuration file that was generated in an older version of SYSCON, 
the following message will open: 
 

 
Figure 2.9. Version Mismatch Message Box 

 
To upgrade the configuration, go to the Project File menu and click Save as, typing a new name for 
the project or using the same name to override the old project. 
 
If the user upgrades the configuration converting it to the new file format, it won't be possible to 
open the configuration in an older version of SYSCON again. 
 
If SYSCON detects that the user is trying to open a configuration file that was generated in a newer 
version, the following message will open: 
 

 
Figure 2.10. Version Mismatch Message Box 

 
NOTE 

Pay close attention to this new characteristic because it only exists starting from version 5.10! 
 

IMPORTANT 
Versions prior to 5.10 do not verify the configuration file. Those versions will open the project file 
generated in a newer version causing no error warnings, but the consistency of the project will not 
be assured. 

 

2.1.4 Save 
 
To save the changes made to the project or any of its parts, such as the Process Cell window or the 
Strategy window, go to the Project File menu and click Save, as the following figure shows: 
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Figure 2.11. Project File Menu: Save 

 
Shortcuts: 
 
Toolbar:  

 
This procedure will save the changes made in the window that has the focus of the application. 
 

REMEMBER 
Anytime the Project configuration changes, do not forget to save. 

 

2.1.5 Save As 
 
To save the project with another name, go to the Project File menu and click Save as, as in the 
following figure: 
 

 
Figure 2.12. Project File Menu: Save As 

 
The Save As dialog box will open: 
 

 

 
Figure 2.13. Save As Dialog Box 

 
Type a new name for the project and click Save. A new folder will be created with the name of the 
project file and the files related to the project will be stored in this folder. 
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2.1.6 Save Entire Configuration 
 
Use this option to save the entire plant project configuration. Go to the Project File menu and click 
Save Entire Configuration, as in the following figure: 
 

 
Figure 2.14. Project File Menu: Save Entire Configuration 

 
Shortcuts: 
 
Toolbar:  

 
NOTE 

A Template is not part of the plant project configuration. It is necessary to set the focus on the 

Template window and click the Save button, , to save the changes made to the template 
configuration. 
 

2.1.7 Close 
 
To close the project, click on the Project window, in case the focus is on another application window, 
go to the File menu and click Close, as in the following figure: 
 

 
Figure 2.15. Project File Menu: Close 

 
Or go to the Window menu and click Close All, as the following figure shows: 
 

 
Figure 2.16. Window Menu: Close All 

 
A quick way of closing a project is to click on the Close button, , in the upper right corner of the 
Project window. 
 
Do not forget to save the project before closing. 
 



Using SYSCON 6.0 
 

2.7 

2.1.8 Print 
 
This section will show SYSCON’s printing options. These options can be found at the Project File 
menu. See the following figure: 
 

 

Printing
Options

 
Figure 2.17. Project File Menu: Print Options 

 

Printer Setup 
This option is available to the Project window and the Strategy window. The user can configure 
page and printer options. 
 
Click this item to open the Page Setup dialog box. See the following figure: 
 

 
Figure 2.18. Page Setup Dialog Box 

 
At the top of the dialog box there’s an example that shows how the page layout will look like. As the 
options change, the page layout example will change. 
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Paper: 
 
• Select the size of the paper or envelope to be used in the Size box. 

• Select where the paper to be used is located in the printer in the Source box. Different printer 
 models support different paper sources, such as the upper tray, envelope feed, and manual 
 feed. 
 
Orientation: select the page orientation and how the document is positioned on the page. To see a 
preview on the example page at the top of the dialog box, check the Portrait box or the Landscape 
box. 
 
Margins (inches): set the printing area of the page, typing a value for the left, right, top and bottom 
margin. 
 
Click on the Ok button to close the Page Setup dialog box and save the changes. 
 
Click on the Cancel button to close the Page Setup dialog box without saving any changes. 
 
Click on the Printer button to open the Printer Setup dialog box and change the printer options. See 
the following figure: 
 

 
Figure 2.19. Printer Setup Dialog Box 

 
At the Printer rectangle, select the printer in the Name box. Click the Properties button to set up 
options for the printer. The Printer rectangle also shows information about the selected printer. 
 
Click on the Ok button to close the dialog box and save the changes. 
 
Click on the Cancel button to close the dialog box without saving any changes. 
 

Printing the Project Configuration 
When the user clicks on the Project window and selects the option Print, or clicks the Print button, 

, on the General Operation toolbar, the Print Configuration dialog box will open. The items of the 
project to be printed can be chosen. See the following figure: 
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Figure 2.20. Print Configuration Dialog Box 

 
Process Control Configuration: Select this item to print the information about the Process Control 
Configuration. 
 

General Information: prints the general information about the configuration. 
 
Blocks: prints the information about the blocks, listed by control modules. 
 
FB Links: prints the information about the links between those blocks. 
 
Other Components: prints further information about the Process Control 
Configuration. 

 
Multi Link Topology: Select this item to print the information about the topology, with the bridges 
and fieldbuses. 
 
Fieldbus Configuration: Select this item to print the information about the Fieldbus Configuration. 
 

General Information: prints the information about the configuration. 
 
Blocks: prints the information about the blocks, listed by devices. 
 
FB Links: prints the information about the links between those blocks. 
 
Other Components: prints further information about the Fieldbus Configuration. 

 
Device List: Select this item to print the information about the devices and their attributes. 
 
Block List: Select this item to print the information about the blocks. 
 

General Information: prints the information about blocks, their attributes and location. 
 
Parameter Values: prints the information about the parameters configured for the 
blocks. 
 
FB Links: prints the information about the connected parameters. 

 
FB Link List: Select this item to print the list with all of the links in the configuration. 
 

General Information: prints the general information about the links. 
 
Connected Parameter: prints the information about the parameters. 

 
Schedule: Select this item to print the information about the Schedule, including both Function 
Block Execution Schedule and Traffic Schedule. 
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Click on the Ok button to close this dialog box and print the project configuration. 
 
Click on the Cancel button to close the dialog box without printing the project configuration. 
 
Click on the Help button to open the Help window. 
 

Printing the Strategy Drawing 
When the user clicks on the Strategy window and selects the option Print, or clicks the Print button, 

, on the General Operation toolbar, the Print dialog box will open and the printer options can be 
configured. See the following figure: 
 

 
Figure 2.21. Print Dialog Box 

 
Printer: shows information about the selected printer. 
 
• Select the printer in the Name box. 

• Click on the Properties button to set up options for the printer. 

 
Print Range: specify whether to print the entire document or specific pages. 
 
• Click on the All box to print the entire drawing area. 

• Click on the Pages box to select the pages to be printed, typing the pages number in the from: 
 box and in the to: box. 

 
Copies: select the number of copies to be printed. 
 
• Type or select a number at the Number of copies box. 

• If more than one copy is selected, check the Collate box to print the document sequentially. If 
 this box is not checked, the first page will be printed as many times as it is defined by the 
 number of copies. The same will happen to the second page and so on. 

 
Click on the Ok button to close this dialog box and print the project configuration. 
 
Click on the Cancel button to close the dialog box without printing the project configuration. 
 

Print to File 
This option is only available on the Project window. When the user clicks this item, the Print 
Configuration dialog box will open. The user can choose the items of the project to be printed. (See 
the section Printing the Project Configuration above.) 
 
When the user clicks Ok, the Save As dialog box will open: 
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1. In the Save in box, choose the folder where the file will be saved. 

2. Type the name for the file in the File name box. The file will be saved as a Report File (*.txt). 

3. Click Save to conclude this task 
 
See the following figure: 
 

 
Figure 2.22. Save As Dialog Box 

 
To print this file, open the folder that contains the file in My Computer or Windows Explorer. Select 
the file icon and right-click on it to activate the popup menu. Click the option Print. The project 
configuration will be printed. 
 

Print Preview 
This option is available to the Project window and the Strategy window. It allows the user to view the 
report before printing it. Use the Project File menu, item Print Preview, or click the Print Preview 

button, , on the General Operation toolbar. 
 
When the user clicks on the Project window and selects this item, the Print Configuration dialog box 
appears. The user can choose the items of the project to be printed. (See the section Printing the 
Project Configuration above.) 
 
Click Ok and the Preview window will open. See the following figure: 
 

 
Figure 2.23. Print Preview: Project Window 
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The Preview window has its own toolbar: 
 

 
Figure 2.24. Print Preview Toolbar 

 
Read a brief explanation about the buttons: 
 

 Click this button to view the anterior page. 

 Click this button to view the next page. 

 Click this button to view the entire page in the screen. 

 Click this button to view two pages, at the same time, in the screen. 

 
Click this button to activate the Zoom tool. Click over the page to 
increase the visualization size. 

 
Click this button to deactivate the Zoom tool. Click over the page to 
decrease the visualization size. 

 This box shows the page(s) that are being visualized at the moment. 

 Click this button to print the report. It will open the Print dialog box. 

 
Click this button to close the Preview window and return to the 
SYSCON browser. 

 
When the user clicks on the Strategy window and selects this item, the Preview window 
automatically appears. See the following figure: 
 

 
Figure 2.25. Print Preview: Strategy Window 

 

When the user clicks the Print button, , the Print dialog box appears. Click Ok to print the 
Strategy drawing. (See the section Printing the Strategy Drawing above.) 
 

2.1.9 Pack Project 
 
SYSCON can pack all of the project configuration files, including the DD and CF files, in a single 
compacted file or as a project folder, according to the preferences set by the user (See section 2.2.4 
Pack and Go Tab). 
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Follow this procedure to pack the project configuration files: 
 
1. Open the desired configuration project. 

2. Go to the Project File menu and click Pack Project. 

3. A dialog box will open warning the user to check if the Device Support has all of the DDs and 
CFs files used in the project. Click Ok to continue. 

4. Select the directory where the project package folder or the compacted file will be created and 
click Ok. 

5. A message box will appear informing the user if the operation was successful. 

6. Click Ok to conclude. 

 

2.1.10 Unpack Project 
 
Follow this procedure to unpack a project configuration: 
 
1. Go to the Project File menu and click Unpack Project. 

2. Select the directory where the project package folder (or the compacted file) is located and click 
 Ok. 

3. Select the directory where the project package folder (or the compacted file) will be saved and 
 click Ok. 

4. A message box will appear informing the user that the operation was successful. 

5. Click Ok to conclude. 

 
2.2 Preferences 

 
To set the project preferences, go to the Project File menu and click Preferences. The Preferences 
dialog box will open: 
 

 
Figure 2.26. Preferences Dialog Box 

 

2.2.1 Block Tab 
 
Tag Policy: choose one of the options for the block tag name generation: 
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• Default: when creating a block, attached to the Strategy or to the device, its tag will have the 
 default format: ["block" + id number]. 

• Device: when creating a new block, attached to the device, its tag will have the device tag 
 concatenated with the block mnemonic and an internal sequential number: [device tag + 
 separator + block mnemonic + id number]. 
 
• Strategy: when creating a new block, attached to the Strategy, its tag will have the Strategy tag 
 concatenated with the block mnemonic and an internal sequential number: [strategy tag + 
 separator + block mnemonic + id number]. 
 
Update Block Tag: if this option is selected, the block tag will be updated when the block is moved to 
another device or control module, or when the device tag or the control module tag is changed, 
according to the options selected by the user to automatically generate block tags. 
 

HINT 
Leave this option unmarked to prevent the block tag to be accidentally changed when the block is 
moved or the device is renamed, for example. 

 
Apply Template Tag Instead of Block Type Mnemonic: if this option is selected, the block tag from 
the Template file will be used instead of the block mnemonic, when importing a Device, Bridge or 
Strategy template. 
 

NOTE 
If the tag based on the device or the Strategy exceeds 32 characters, that is [device or strategy 
tag + separator + block mnemonic + id number] has more than 32 characters, the block tag will be 
generated according to the Default option: ["block" + id number]. 

 
See the section Automatic Block Tag Generation for further details. 
 
 
Tag Composition: this tab will be available if the block tag name generation is based on device 
or the Strategy tag. 
 
The Mnemonic Separator is a set of alphanumeric characters that separates the name of the device 
or Strategy from the name of the block. 

The user can choose if the device or Strategy tag should be applied as a prefix or suffix in the block 
tag. 
 

 
Figure 2.27. Additional Options 

 



Using SYSCON 6.0 
 

2.15 

 
Communication: enable the Automatic Checking for the block events by selecting the Block List 
Events option. The Automatic Checking verifies if the list of block attached to the device match the 
list of block attached to the corresponding device in the field, for all devices on the Fieldbus windows 
that are open. If this option is not selected, the Checking will be executed when the user opens the 
Block List. 
 

 
Figure 2.28. Communication Option 

 
NOTE 

It is necessary to re-initialize the communication every time the Preferences for the Block List 
Events option change, so the changes will take effect. 

 
Export Tag: select the mode for the Export Tags operation and the path for the taginfo.ini file, 
where the tags will be saved. 
 
▪ Manual: the user must execute the Export Tags command to update the information 

in the taginfo.ini file. 
 
▪ Automatic: the Export Tags operation will be executed every time a relevant online 

procedure requires the tag to be exported. In this mode, a message box will open 
for the user to confirm the Export Tags operation. 

 

 
Figure 2.29. Export Tag Options 
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2.2.2 Device and Bridge Tab 
 
The user can set the options to automatically create and configure blocks, parameters and internal 
links when a device or bridge is added to the configuration, according to the Capabilities File. 
 

 
Figure 2.30. Device & Bridge Options 

 
Creation Based on Default Template: Select this option to create the blocks, parameters and 
internal links based on the Default Template file of the device being created, located in the 
corresponding Device Support folder. If the Default Template is not found, SYSCON will 
automatically create the Resource Block and the Transducer Blocks of the selected device. 
 
Create Resource Block: Select this option to automatically create the Resource Block of the 
selected device, according to the Capabilities File. 
 

MODE_BLK.TARGET Parameter: Select the default initial value for the Mode Block Parameter: 
AUTO or OOS. 

 
Create Transducer Blocks: Select this option to automatically create the Transducer Blocks of the 
selected device, according to the Capabilities File. 
 

MODE_BLK.TARGET Parameter: Select the default initial value for the Mode Block Parameter: 
AUTO or OOS. 

 
 

2.2.3 Strategy Tab 
 
Select the default block format to be used when a block is added to the Strategy window. The ellipse 
(more exactly a circle) is the default graphical representation for a block in SYSCON. 
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Figure 2.31. Strategy Options 

 
The following figure shows the different block formats: 
 

Ellipses Rectangles Rounded
Rectangles

 
Figure 2.32. Block Formats 

 

2.2.4 Pack and Go Tab 
 
All of the project configuration files, including the DD and CF files, can be packed and sent to 
another machine, where SYSCON will unpack the files. 
 

 
Figure 2.33. Pack & Go Options 

 



SYSCON 6.0 - Users’ Manual 
 

2.18 

 
Select one of the options: 
 
No Compactor: the configuration package will be a folder that contains all of the necessary files. 
 
Use GZip Compactor: the configuration package will be a compacted file. The application used is 
the GZip Compactor. The GZip installation file is included in the SYSTEM302 Installation CD, at the 
Tools folder. The compacted file will have the extension *.tgz, and it is compatible with Winzip and 
other applications. 
 
 

2.2.5 Device Support Tab 
 
Select the default path to browse for files that are missing in the Device Support, using the option 
Import Device Support from the Project File menu. 
 

 
Figure 2.34. Device Support Options 

 
If the user selects another folder while importing the files, this new path will be the default one. This 
means that SYSCON will always store the last path selected by the user. 
 
 

2.3 Automatic Block Tag Generation 
 
When the user creates a new block and does not define a tag to it, the tag is automatically 
generated and assigned to the block, based on the Preferences settings. 
 

2.3.1 Default Block Tag 
 
The default tag for a new block is described as follow: 
 
["Block" + id number] 
 
Where: 
 
Block: the default text for a block. 
id number: a sequential number that identifies the block internally in the project. 
 
 

2.3.2 Block Tag Based On Device Tag 
 
When the tag generation is based on the device tag, if a new block is created in a device and the 
user does not define a tag to it, then the block tag will have the following format: 
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• Using the Device Tag as prefix: 
[device tag + separator + block mnemonic + id number] 

 
• Using the Device Tag as suffix: 

[block mnemonic + id number + separator + device tag] 
 
Where: 
 
device tag: the tag of the device where the block is attached to. 
 
separator: a set of alphanumeric characters that separates the name of the device from the name 
of the block. 
 
block mnemonic: a set of characters related to the block type. 
 
id number: a sequential number related to the mnemonic of the block. 
 

NOTE 
Assuming that the option Update Block Tag is selected in the Preferences dialog box: 

• If the user changes the device tag, the tag of all blocks attached to this device will be 
updated based on the new device tag. 

• If the block is moved from one device to another, its tag will be automatically updated based 
on the tag of the target device. 

 
If a new block is created in the Strategy and the user does not define a tag to it, the block tag will be 
generated based on the Strategy tag since the block is not attached to any device yet. Once the 
user attaches the block to a device, the block tag will be automatically updated based on this device 
tag. 
 
Yet, if a block is detached from a device, the block tag will be updated again based on the Strategy 
tag. 
 

NOTE 
The general rule is if the block is not attached to a device but is attached to a Strategy, the block 
tag will be automatically generated based on the Strategy tag, even if the tag generation method 
chosen is based on device tag. 

 
 

2.3.3 Block Tag Based On Strategy Tag 
 
When the tag generation is based on the Strategy tag, if a new block is created in a Strategy and 
the user does not define a tag to it, then the block tag will have the following format: 
 
• Using the Strategy Tag as prefix: 

[strategy tag + separator + block mnemonic + id number] 
 
• Using the Strategy Tag as suffix: 

[block mnemonic + id number + separator + strategy tag] 
 
Where: 
 
strategy tag: the tag of the Strategy where the block is attached to. 
 
separator: a set of alphanumeric characters that separates the name of the Strategy from the name 
of the block. 
 
block mnemonic: a set of characters related to the block type. 
 
id number: sequential number related to the mnemonic of the block. 
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NOTE 

Assuming that the option Update Block Tag is selected in the Preferences dialog box: 

• If the user changes the Strategy tag, the tag of all blocks attached to this Strategy will be 
updated based on the new Strategy tag. 

• If the block is moved from one Strategy to another, its tag will be automatically updated based 
on the tag of the destination Strategy. 

 
If a new block is created in the device and the user does not define a tag to it, the block tag will be 
generated based on the device tag since the block is not attached to any Strategy yet. Once the 
user attaches the block to a Strategy, the block tag will be automatically updated based on this 
Strategy tag. 
 
Yet, if a block is detached from a Strategy, the block tag will be updated again based on the device 
tag. 
 

NOTE 
The general rule is if the block is not attached to a Strategy but is attached to a device, the block 
tag will be automatically generated based on the device tag, even if the tag generation method 
chosen is based on Strategy tag. 

 
 

2.4 Exporting and Importing Information 
 
SYSCON can export and import the list of Blocks in the Exchange File Format. The user must 
provide the file to be exported, or imported, with the tags of the blocks. 
 
From SYSCON version 6.0 on, any configuration project can be exported as a XML file, that will 
have all the information found in the FFP file. When importing the configuration, the XML file is 
validated by a XML Schema and the configuration consistency is checked. 
 

2.4.1 Exporting the List of Blocks 
 
Before exporting the list of blocks, it is necessary to generate the .ini file that contains the tags of all 
blocks that will be exported. The .ini file has the following format: 
 

 
Figure 2.35. Export File Format 

 
To export the list of blocks, go to the Project File menu and click Export > List of Blocks, as the 
following figure shows: 
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Figure 2.36. Project File Menu: Export List of Blocks 

 
The dialog box will open: 
 

 
Figure 2.37. Export List of Blocks dialog box 

 
Click the Browse button to search for the Export Template File, assuming that the user has 
previously created the file with the tags of the blocks. See section Exporting Tags for further 
information. 
 

 
Figure 2.38. Selecting the Template File 

 
Select the option Export into a new file to create a new file for the list of blocks. Then select the 
destination file clicking the corresponding Browse button. 
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Figure 2.39. Selecting the Destination File 

 
Click Ok to export the list of blocks and conclude this task. 
 
 

2.4.2 Importing the List of Blocks 
 
The figure below shows an example of a file in the Exchange File Format that can be import in the 
SYSCON application: 
 

 
Figure 2.40. Export File Format 

 
To import the list of blocks, go to the Project File menu and click Import > List of Blocks, as the 
following figure shows: 
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Figure 2.41. Project File Menu: Import List of Blocks 

 
The dialog box will open: 
 

 
Figure 2.42. Import List of Blocks dialog box 

 
Click the Browse button to search for the Import Template File. 
 

 
Figure 2.43. Selecting the Template File 

 
Click Ok to import the list of blocks and conclude this task. 
 

2.4.3 Exporting the Configuration as XML 
 
To export the configuration as a XML file, go to the Project File menu and click Export > 
Configuration as XML, as the following figure shows: 
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Figure 2.44. Project File Menu: Export Configuration as XML 
 
The dialog box will open: 
 

 
Figure 2.45. Export Configuration as XML dialog box 

 
Type a name for the XML file and click Save. 
 
 

2.4.4 Importing the Configuration as XML 
 
To import the configuration from a XML file, go to the Project File menu and click Import > 
Configuration as XML, as the following figure shows: 
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Figure 2.46. Project File Menu: Import Configuration as XML 

 
The dialog box will open: 
 

 
Figure 2.47. Import Configuration as XML dialog box 

 
Select the XML file to be imported and click Open. 
 
 

2.5 Security 
 
With SYSCON 6.0, it is possible to prevent the configuration file to be open by unauthorized users. 
 
The users database must be installed with the application. 
 
Only the user “Administrator” can change and configure the user’s database. The Administrator is 
the default user of the Security Manager. It can’t be removed from the list, but the password can be 
changed. 
 

IMPORTANT 
When using the Security Manager for the first time, the default user will be Administrator and the 
default password will be UnitXVI. 

 

2.5.1 Enabling the Security 
 
Only the Administrator can activate and deactivate the Security Manager. 
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Go to the Project File menu and click Security, as the following figure shows: 
 

 
Figure 2.48. Project File Menu: Security 

 
The Security dialog box will open: 
 
1. Type Administrator as the User Name. 

2. Type the Password. 

3. Click the Login button. 
 

 
Figure 2.49. Administrator Login 

 
The Active box will become enabled. 
 

 
Figure 2.50. Security Manager Enabled 

 
To activate the Security Manager, select the option Active. It will be necessary to log to the 
SYSCON before opening the application. 
 
To deactivate the Security Manager, clear the option Active. The Security Manager will not verify 
users access and any user can run the SYSCON and open a configuration file. 
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NOTE 

The Security Manager is deactivated by default. It is necessary to follow this procedure and 
activate the Security when using SYSCON for the first time. 

 

2.5.2 User Login 
 
Go to the Project File menu and click Security, as the following figure shows: 
 

 
Figure 2.51. Project File Menu: Security 

 
The Security dialog box will open: 
 

 
Figure 2.52. Security dialog box 

 
1. Type the User Name. 

2. Type the Password. 

3. Click the Login button. 
 
If the information is correct, the user will be logged in the application. Click Ok to close the Security 
dialog box and start using SYSCON. 
 

REMEMBER 
The User Name and the Password are case sensitive. 
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2.5.3 User Logout 
 
To logout from the Security Manager, go to the Project File menu and click Security, to open the 
dialog box. 
 
Click the button Logout. A message box will open to confirm the operation. 
 

2.5.4 Users Management 
 
The user with the Administrator profile can change any attribute of a user. 
 
The user with the User profile can only change the password. 
 
To manage the users in the database, click the Change button in the Security dialog box. 
 

 
Figure 2.53. Security dialog box 

 
The dialog box will expand: 
 

 
Figure 2.54. Security dialog box: User Attributes 

 
The Change Password area is used to change the user’s password. The password must have at 
least four alphanumeric characters. 
 
The User List displays the users that can log to the SYSCON application. 
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The option Enabled is used to enable or disable an user account. When an user account is disabled, 
the account still exist in the database but the user will not be able to log in or run the SYSCON 
application. 
 

Creating a User 
Only an user with the Administrator profile can add users to the Security Manager. 
 
To add a new user to the User List: 
 
1. Type the login name for the user in the User Name text box. 

2. Type the new password in the New text box and re-type the password in the Repeat text box. 

3. Type the full name of the user in the Name text box. 

4. Type a description of the user in the Descr text box. 

5. Click Add to include the new user. 
 

User Profile 
The Profile option determines the type of access for the user. 
 

 
Figure 2.55. Profile Options 

 
The Adm profile allows the user to create, update or remove users from the database. It is not 
possible to change the information about the Administrator. 
 
The Mng profile allows the user to modify the password and verify the information about the other 
users. It is not allowed to create, update or remove users from the database. 
 
The Usr profile allows the user to log and run the SYCON application. This user doesn’t have 
access to the information about the other users. The Change button will be disabled. 
 

Updating the Attributes for the User 
The user with the Administrator profile can change any attribute of a user. 
 
The user with the User profile can only change the password. 
 
To update the attributes for a user, select the name from the User List. The information about the 
user will be displayed in the Security dialog box. 
 
The password, the profile, the name, the description and also the user name can be changed. 
 
Enter the new information about the user and click the button Update to save the values. 
 

Changing the Password 
To change the password: 
 
1. Select the name of the user in the User List. 

2. Type the new password in the New text box. 

3. Re-type the password in the Repeat text box. 
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4. Click Confirm. 

5. Click Yes to apply the changes to the password. 

 
 

Removing a User 
Only an user with the Administrator profile can remove users from the Security Manager. 
 
To remove a user from the database, select the user name in the User List and click the button 
Remove. 
 
A message box will be displayed to confirm this operation. Click Yes to remove the user or click No 
to cancel. 
 
 

NOTE 
It is not possible to remove a user that is logged to the system. 

 
 



Section 3 
 

3.1 

3 Fieldbus Configuration 
3.1 Plant 

3.1.1 Changing Plant Attributes 
 
To change the plant name, right-click the plant icon and select the item Attributes. 
 

 
Figure 3.1. Plant Attributes 

 
NOTE 

Using the mouse with left hand, check whether the Right Button Configuration of the mouse, on 
the Mouse Properties window, is set to open the “Context Menu”. If not, use the Left Mouse 
Button to open the “Popup Menu”, instead of the Right Mouse Button. 

 
The Plant Attributes dialog box will open. Type the new plant tag and click OK. 
 

 
Figure 3.2. Plant Attributes Dialog Box 

 

3.2 Areas 

3.2.1 Changing Area Attributes 
 
To change the area tag, select the area icon, go to the Edit menu and click Attributes. Or activate 
the area popup menu, right-clicking its icon and selecting the item Attributes. 
 

 
Figure 3.3. Area Attributes 
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The Area Attributes dialog box will open. Type the new area tag and click OK. 
 

 
Figure 3.4. Area Attributes Dialog Box 

 

3.3 Process Cells 

3.3.1 Creating Process Cells 
 
To create a process cell, select the area icon, go to the Edit menu and click New Process Cell. Or 
activate the area popup menu, right-clicking its icon and selecting the item New Process Cell. 
 

 
Figure 3.5. New Process Cell 

 
The Process Cell dialog box will open. Type the process cell tag and click OK. 
 

 
Figure 3.6. Process Cell Dialog Box 

 
 

NOTE 
If a new tag is not typed, Process Cell n will be the default, where n is a sequential number for the 
process cells. 

 
 
After creating the process cell, the Project window will look like the following figure: 
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Figure 3.7. Project Window 

 
The process cell has its own window: click the process cell icon, go to the View menu and click 
Expand to activate this window. Or activate the process cell popup menu, right-clicking its icon and 
selecting the item Expand, as indicated below: 
 

 
Figure 3.8. Expanding the Process Cell Window 

 
The Process Cell window will open: 
 

 
Figure 3.9. Process Cell Window 

 
Another easy way of opening the Process Cell window is to double-click the process cell icon on the 
Project window. 
 
 

3.3.2 Changing Process Cell Attributes 
 
To change the process cell attributes, select the process cell icon on the Process Cell window, go to 
the Edit menu and click Attributes. Or activate the process cell popup menu, right-clicking its icon on 
the Process Cell window and selecting the item Attributes. 
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Figure 3.10. Process Cell Attributes 

 
The Process Cell dialog box will open. Type the new process cell tag and click OK. 
 

 
Figure 3.11. Process Cell Dialog Box 

3.3.3 Deleting Process Cells 
 
To remove a process cell, select its icon on the Project window, go to the Edit menu and click Delete 
Process Cell. Or activate the process cell popup menu, right-clicking its icon and selecting the item 
Delete Process Cell. 
 

 
Figure 3.12. Deleting the Process Cell 

 
A quick way of removing a process cell is to select its icon on the Project window and press the 
Delete key, on the keyboard. 
 
The Warning dialog box will open. To confirm the deletion, click Yes. 
 

 
Figure 3.13. Confirm Deletion Dialog Box 

 
NOTE 

If the user confirms the operation, the process cell and the control modules will be removed from 
the project and will not be sent to the Recycle Bin. 
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3.4 Control Modules 

3.4.1 Creating Control Modules 
 
To create a control module, open the Process Cell window and select the process cell icon. Go to 
the Edit menu and click New Control Module. Or activate the process cell popup menu, right-clicking 
its icon on the Process Cell window and selecting the item New Control Module. 
 

 
Figure 3.14. New Control Module 

 
The Control Module dialog box will open. Type the control module tag and click OK. 
 

 
Figure 3.15. Control Module Dialog Box 

 
 

NOTE 
If a new tag is not typed, Control Module n will be the default, where n is a sequential number for 
the control modules. 

 
 
The Process Cell window will look like the following figure: 
 

 
Figure 3.16. Process Cell Window 

 

3.4.2 Changing Control Module Attributes 
 
To change the control module attributes, select its icon, go to the Edit menu and click Attributes. Or 
activate the control module popup menu right-clicking its icon and selecting the item Attributes: 
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Figure 3.17. Control Module Attributes 

 
The Control Module dialog box will open: 
 

 
Figure 3.18. Control Module Attributes Dialog Box 

 
Type the new control module tag. 
 
The user can also set a value for the Stale Count. The Stale Count is the number of Macrocycles 
used to signal that the data was not updated in the Link. 
 
Click OK to close this dialog box. 
 

3.4.3 Deleting Control Modules 
 
To remove a control module from a process cell, select its icon, go to the Edit menu and click Delete 
Control Module. Or activate the control module popup menu right-clicking its icon and selecting the 
item Delete Control Module: 
 

 
Figure 3.19. Deleting the Control Module 

 
A quick way of removing a control module is to select its icon on the Process Cell window and press 
the Delete key, on the keyboard. 
 
The Warning dialog box will open. To confirm the deletion, click Yes. 
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Figure 3.20. Confirm Deletion Dialog Box 

 
NOTE 

If the user confirms the operation, the control module and the related Strategy will be removed 
from the project and will not be sent to the Recycle Bin. 

 
 

3.5 Fieldbus Networks 

3.5.1 Creating Fieldbuses 
 
To create a fieldbus, select the fieldbus networks icon, go to the Edit menu and click New Fieldbus. 
It is also possible to activate the fieldbus networks popup menu, right-clicking its icon and selecting 
the item New Fieldbus. 
 

 
Figure 3.21. New Fieldbus 

 
The New Fieldbus dialog box will open. Select the communication type for the fieldbus and type the 
tag in the Tag text box, and then click OK. 
 

 
Figure 3.22. Fieldbus Dialog Box 

 
NOTE 

If the HSE type is selected, the HSE Host will be automatically added to the fieldbus channel and 
the HSE OLE Server will be automatically selected in the Communication Settings. 

 
 
If the user doesn't type a tag, the default one will be Fieldbus n, where n is a sequential number for 
the fieldbuses. The Fieldbus Network doesn’t have a direct correspondence to any of the existing 
process cells. 
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When the user is finished creating the fieldbus, the Project window should look like the following 
figure: 
 

 
Figure 3.23. Project Window 

 
The fieldbus has its own window: click the fieldbus icon, go to the View menu and click Expand to 
activate this window. Or activate the fieldbus popup menu, right-clicking its icon and selecting the 
item Expand: 
 

 
Figure 3.24. Expanding the Fieldbus Window 

 
The Fieldbus window will open: 
 

 
Figure 3.25. Fieldbus Window 

 
Another easy way to open the Fieldbus window is to double-click the fieldbus icon on the Project 
window. 
 
 

3.5.2 Changing Fieldbus Attributes 
 
To change the fieldbus attributes, select the fieldbus icon on the Fieldbus window, go to the Edit 
menu and click Attributes. Or activate the fieldbus popup menu, right-clicking its icon on the 
Fieldbus window and selecting the item Attributes. 
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Figure 3.26. Fieldbus Attributes 

 
The Fieldbus dialog box will open. 
 

 
Figure 3.27. Fieldbus Dialog Box 

 
Type the new fieldbus tag. 
 
The user is now able to determine the time dedicated to the Background Traffic. The Background 
Traffic (in ms) will affect the refreshing time of the variables under supervision. The minimum value 
is 100 ms. The macrocycle is automatically updated. 
 
To set the macrocycle: 
 
1. Type the new value for the macrocycle. 

2. Click Override. 
 
The values for the Background Traffic and the Foreground Traffic are calculated. 
 
Click Ok to accept these values and conclude this task. 
 
In case the user wants to restore the macrocycle to the default value, click Default and then click 
Ok, as the following figure shows: 
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Figure 3.28. Fieldbus Macrocycle Default Value 

 
After clicking Override or Default (before closing the Fieldbus dialog box) the previous value of the 
macrocycle can be restored by clicking Cancel. 
 

 
Figure 3.29. Cancel Button 

 
 

NOTE 
Click the button Cancel to quit the dialog box without applying the changes to the fieldbus. All 
modifications will be discarded, and all fieldbus parameters will be restored to the initial state. 
 
 

3.5.3 Deleting Fieldbuses 
 
To remove a fieldbus, select its icon on the Project window, go to the Edit menu and click Delete 
Fieldbus. Or activate the fieldbus popup menu, right-clicking its icon and selecting the item Delete 
Fieldbus. 
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Figure 3.30. Deleting the Fieldbus 

 
A quick way of removing a fieldbus is to select its icon on the Project window and press the Delete 
key, on the keyboard. 
 
The Warning dialog box will appear. To confirm the deletion, click Yes. 
 

 
Figure 3.31. Confirm Deletion Dialog Box 

 
NOTE 

If the user confirms the operation, the fieldbus and the devices will be removed from the project 
and will not be sent to the Recycle Bin. 

 
 

3.6 Devices 

3.6.1 Creating Devices 
 
To create a device, open the Fieldbus window and select the fieldbus icon. Go to the Edit menu and 
click New Device. Or activate the fieldbus popup menu, right-clicking its icon in the Fieldbus window 
and selecting the item New > Device. 
 

 
Figure 3.32. New Device 

 
The New Device dialog box will open: 
 
1. Select a Device Manufacturer from the list. 

2. Select the Device Type provided by the manufacturer selected. 

3. Select the Device Revision. 
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4. Select the DD Revision and the CF Revision, or check the option Follow the Latest DD/CF 
 Revision to apply the latest revision for the selected device. 

 
NOTE 

If the option Follow the Latest DD/CF Revision is selected, SYSCON will update the device with 
the latest revision of the DD and CF everytime the configuration file is opened. To disable the 
automatic update, right-click the device icon, select Exchange from the menu and clear this 
option. 
 
 
5. Type the Device ID. 

6. Type a related tag for the device. 

 
Figure 3.33. Device Dialog Box 

 
At the Advanced Options tab: 
 

 
Figure 3.34. Advanced Options 

 
Select the option Creation Based on Default Template to create the device based on the Default 
Template file for the selected Device Revision, located in the corresponding Device Support folder. 
 
Select the option Create Resource Block to automatically create the Resource Block of the 
selected device. The user can set the initial value for the Mode Block Parameter. 
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Select the option Create Transducer Blocks to automatically create the Transducer Blocks of the 
selected device. The user can set the initial value for the Mode Block Parameter. 
 
Click Ok to add the device to the configuration. 
 

NOTE 
If the Default Template file is not found, SYSCON will automatically created the Resource and 
Transducer Blocks for the selected device. 
If the user does not type a tag, Device n will be the default, where n is a sequential number for the 
devices. 

 
The Fieldbus window should look like the following figure: 
 

 
Figure 3.35. Fieldbus Window 

 
IMPORTANT 

The HSE Device can only be added to the HSE Fieldbus. 
Equally, the H1 Device can only be added to the H1 Fieldbus. 

 
 

3.6.2 Creating Device from Template 
 
To create a device based on a Device Template File, select the fieldbus icon, go to the Edit menu 
and click Import Device Template. Or activate the fieldbus popup menu, right-clicking its icon in the 
Fieldbus window and selecting the item New > Device from Template. 
 

 
Figure 3.36. Creating Device from Template 

 
The dialog box will open: 
 
1. Select the directory where the file is located. 

2. Select the Device Template file and click Open. 

3. A message box will open to confirm the operation. Click Ok to import the Device Template. 
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Figure 3.37. Selecting the Device Template 

 
The Tag Table will open, showing the list with the block tags based on the preferences settings and 
the old block tags used in the Template file. To edit a tag, right-click the block or device icon at the 
New Tag column and click Rename. Type the new tag and click Enter on the keyboard. 
 
Click Ok to close Tag Table dialog box and add the device to the configuration. 
 
 

3.6.3 Changing Device Attributes 
 
To change the device attributes, select its icon, go to the Edit menu and click Attributes. Or activate 
the device popup menu, right-clicking its icon and selecting the item Attributes. 
 

 
Figure 3.38. Device Attributes 

 
The Device Attributes dialog box will open. Change the attributes of the device and click OK: 
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Figure 3.39. Device Attributes Dialog Box 

 
NOTE 

When SYSCON is operating in On-line mode, the Device ID list box will show the devices that 
haven't been instantiated in the project yet. 
If the user selects Unspecified in the Device Tag list box and applies it to the device, SYSCON will 
automatically generate a new default tag for the device, based on the Preferences. 

 
 

Master Backup Device 
To make a device work as a Master Backup, a Link Master should be selected: 
 
1. Click the down arrow of the BOF Class box. 

2. Select the option Link Master. 

3. Click Ok. 
 
See the following figure: 
 

 
Figure 3.40. Configuring the Link Master Device 

 
When SYSCON is online, activate the device menu and select the option Change BOF Class. 
SYSCON will promptly show a message asking to re-initialize the device. The device will operate as 
a Link Master. 
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NOTE 

During the download, all Master Backups in the Fieldbus Network will be configured with 
the Traffic Schedule. 

 
 

3.6.4 Deleting Devices 
 
To remove a device from the Fieldbus window, select its icon, go to the Edit menu and click Delete 
Device. Or activate the device popup menu, right-clicking its icon and selecting the item Delete 
Device: 
 

 
Figure 3.41. Delete Device 

 
A quick way of removing a device is to select its icon on the Fieldbus window and press the Delete 
key, on the keyboard. 
 
The Warning dialog box will appear. To confirm the deletion, click Yes. 
 

 
Figure 3.42. Confirm Deletion Dialog Box 

 

3.6.5 Ordering Devices 
 
Select a device icon and drag it over the other device icon. The device selected will be placed above 
the first one on the list. 
 

Mouse Cursor

 
Figure 3.43. Ordering Devices at the Fieldbus Window 

 
The Fieldbus window should look like the following figure: 
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Figure 3.44. Fieldbus Window 

 

3.6.6 Moving Devices 
 
Click to select the device icon and drag it over the icon of the target Fieldbus window. 
 

 
Figure 3.45. Moving a Device to Another Fieldbus Window 

 
If there are any block links connecting the device to its original Fieldbus window, these links may no 
longer be available for the communication, because no logical path would be found in the topology. 
The unrealized links will be identified by a dotted line in the Strategy window. 
 
 

3.6.7 Device Exchange 
 
When a defective device must be replaced by a new device that has a newer or different Device 
Revision, it is possible to exchange these devices easily without modifying the existing 
configuration. Another scenario occurs when the user wants to change the Device Revision for a 
device. 
 
If SYSCON is operating in the on-line mode, the user will be able to exchange the Device ID. 
 
The Device Exchange verifies the inconsistencies, incompatibilities and interchangeability problems, 
and generate a report about the changes that will affect the configuration. 
 
To exchange a device, select its icon, go to the Edit menu and click Exchange. Or right-click the 
device icon and click the item Exchange. 
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Figure 3.46. Device Exchange 

 
The Exchange dialog box will open: 
 

 
Figure 3.47. Device Exchange Dialog Box 

 
The user can change the Manufacturer, the Device Type and the Device Revision. 
 
SYSCON will compare the new device configuration with the previous one and display the 
incompatibilities at the Device Exchange Deviations dialog box. 
 
The Deviations dialog box shows detailed information of the device, the blocks and parameters, 
indicating to the user the functionalities that can be lost when exchanging the device. 
 
See the example below: 
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Figure 3.48. Device Deviations Dialog Box 

 
Click the column headers (Attribute, Current, Alternative, Severity or Index column) on the right 
panel to sort the Parameters list. Clicking the column header will toggle between ascendant or 
descendent sorting. 
 
The Deviations dialog box has its own toolbar. The following table describes the functionalities of the 
buttons: 
 

 Click this button to refresh the information on the dialog box. 

 Click this button to expand all nodes. 

 Click this button to collapse all nodes. 

 Click this button to accept the changes and close the Deviations dialog box. 

 Click this button to cancel the exchange procedure and close the Deviations dialog box. 

 Click this button to open the SYSCON Help. 

 
The Deviations dialog box has four filter levels that classifies all of the blocks and parameters 
attributes for the device: 
 

 The attributes classified by this filter are compliant with the device. 

 
The Low Severity filter indicates that the attributes are not compliant but the information 
won't be lost. 

 
The High Severity filter indicates that the attributes are not compliant and the information 
can be lost or converted. 

 This filter will display all of the attributes. 

 
Click Ok to confirm the exchange procedure. SYSCON will verify the compatibility of the blocks. If a 
block is not available in the target device, a message box will alert the user that the block is not 
compliant. The user should search for a compatible block by clicking Yes. The Block dialog box will 
open: 
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Figure 3.49. Selecting a Compatible Block 

 
Select the option Show Compliant With Blocks to display the list of compatible blocks types in the 
target device or select the option Show All Available Blocks to display the list of all blocks types 
available for the target device. Select the block type and click Ok to accept the changes. 
 
This Block dialog box will appear for each unavailable block until all blocks are evaluated. 
 
Blocks that cannot be converted will be removed from the configuration and sent to the Recycle Bin. 
 
Parameters cannot be converted. If there is no identical parameter in the new device, the parameter 
will be deleted and will not be sent to the Recycle Bin. 
 

NOTE 
In the on-line operation mode, when the Exchange procedure is complete, a dialog box alerts the 
user that it is necessary to execute a Device Download and assign the tags. Click Yes to execute 
the download or click No to postpone the download. 

 
 

3.7 Bridges 
 
Use bridges when the user wants a block to supply a value to another block but these block are 
inside different fieldbus links. 
 

3.7.1 Creating Bridges 
 
To create a bridge, select the fieldbus icon, on the Fieldbus window, go to the Edit menu and click 
New Bridge. Or activate the fieldbus popup menu, right-clicking its icon and selecting the item New 
> Bridge. 
 

 
Figure 3.50. New Bridge 
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The New Bridge dialog box will open: 
 
1. Select a Bridge Manufacturer from the list. 

2. Select the Device Type provided by the manufacturer selected. 

3. Select the Device Revision. 

4. Select the DD Revision and the CF Revision, or check the option Follow the Latest DD/CF 
 Revision to apply the latest revision for the selected bridge. 
 

NOTE 
If the option Follow the Latest DD/CF Revision is selected, SYSCON will update the Bridge with 
the latest revision of the DD and CF everytime the configuration file is opened. To disable the 
automatic update, right-click the Bridge icon, select Exchange from the menu and clear this 
option. 

5. Type the Device ID. 
 
6. Type a related tag for the bridge. 
 

 
Figure 3.51. Bridge Dialog Box 

 
At the Advanced Options tab: 
 

 
Figure 3.52. Advanced Options 
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Select the option Creation Based on Default Template to create the bridge based on the Default 
Template file for the selected Device Revision, located in the corresponding Device Support folder. 
 
Select the option Create Resource Block to automatically create the Resource Block of the 
selected bridge. The user can set the initial value for the Mode Block Parameter. 
 
Select the option Create Transducer Blocks to automatically create the Transducer Blocks of the 
selected bridge. The user can set the initial value for the Mode Block Parameter. 
 
Click Ok to add the bridge to the configuration. 
 

NOTE 
If the Default Template file is not found, SYSCON will automatically created the Resource and 
Transducer Blocks for the selected bridge. 
If the user does not type a tag, the default one will be Bridge n, where n is a sequential number 
for the bridges. 

 
When the user is finished creating the bridge, the Project and Fieldbus window should look like the 
following figure: 
 

 
Figure 3.53. Project and Fieldbus Window 

 
In the Project window, the bridge contains the fieldbus. 
 

IMPORTANT 
The HSE Host, linking devices and I/O Gateways can only be added to the HSE Fieldbus. Equally, 
the H1 Bridge can only be added to the H1 Fieldbus. 

 
 

3.7.2 Creating Bridge from Template 
 
To create a bridge based on a Bridge Template File, select the fieldbus icon, go to the Edit menu 
and click Import Bridge Template. Or activate the fieldbus popup menu, right-clicking its icon in the 
Fieldbus window and selecting the item New > Bridge from Template. 
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Figure 3.54. Creating Bridge from Template 

 
The dialog box will open: 
 
1. Select the directory where the file is located. 

2. Select the Bridge Template file and click Open. 

3. A message box will open to confirm the operation. Click Ok to import the Bridge Template. 
 

 
Figure 3.55. Selecting the Bridge Template 

 
The Tag Table will open, showing the list with the block tags based on the preferences settings and 
the old block tags used in the Template file. To edit a tag, click the block or bridge icon at the New 
Tag column to select it, then click it again to enter the edit mode. Type the new tag and click Enter 
on the keyboard. 
 
Click Ok to close the Tag Table dialog box and add the bridge to the configuration. 
 
 

3.7.3 Changing Bridge Attributes 
 
To change the bridge attributes, select the bridge icon, go to the Edit menu and click Attributes. Or 
activate the bridge popup menu, right-clicking its icon and selecting the item Attributes. 
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Figure 3.56. Bridge Attributes 

 
The Bridge dialog box will open. Change the bridge attributes and click Ok to conclude. 
 

 
Figure 3.57. Bridge Attributes Dialog Box 

 
NOTE 

When SYSCON is operating in On-line mode, the Device ID list box will show the bridges that 
haven't been instantiated in the project yet. 
If the user selects Unspecified in the Device Tag list box and applies it to the bridge, SYSCON will 
automatically generate a new default tag for the bridge, based on the Preferences. 

 
 

Changing the Root Bridge 
Observe the following situation: 
 

 
Figure 3.58. Project Window 
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The Fieldbus Networks tree begins from the Bridge1. The user can change this configuration to 
make the Fieldbus Networks tree begin from the Bridge2. 
 
Select the Bridge2 icon and activate its popup menu right-clicking its icon. Click the item Attributes. 
 
The Bridge dialog box will open. Check the Root option and click OK. See the following figure: 
 

 
Figure 3.59. Changing the Root Bridge 

 
Now, the Bridge2 is the root of the Fieldbus Networks tree: 
 

 
Figure 3.60. Project Window 

 

3.7.4 Deleting Bridges 
 
To remove a bridge, select its icon on the Fieldbus window, go to the Edit menu and click Delete 
Bridge. Or activate the bridge popup menu, right-clicking its icon and selecting the item Delete 
Bridge. 
 

 
Figure 3.61. Delete Bridge 

 
A quick way of removing a bridge is to select its icon and press the Delete key, on the keyboard. 
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The Warning dialog box will open. To confirm the deletion, click Yes. 
 

 
Figure 3.62. Confirm Deletion Dialog Box 

 
NOTE 

If the bridge has blocks with External Links, it will be necessary to delete the links before deleting 
the bridge. 

 
 

3.7.5 Connecting a Bridge to a Fieldbus 
 
Note the following situation: 
 

 
Figure 3.63. Project Window 

 
If there have been at least two fieldbuses added to the project, and a bridge connected to one 
fieldbus, the user can connect this bridge to the other one. 
 
Select the bridge icon on the Project window, go to the Edit menu and click Connect to. Or activate 
the bridge popup menu right-clicking its icon and selecting the item Connect to. 
 

 
Figure 3.64. Connect to Fieldbus 

 
The Connect Bridge to dialog box will open: 
 
1. Select the fieldbus in the Tag box. 

2. Select the port to connect the fieldbus, in the Upstream Port. 

3. Click Ok. 
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Figure 3.65. Connect Bridge Dialog Box 

 
NOTE 

If the user is connecting the bridge to a HSE fieldbus, the Upstream Port field will not be active. 
Only one bridge can be connected to the HSE Fieldbus. 

 
The following figure shows the project tree after the connection: 
 

 
Figure 3.66. Project Window 

 
The Fieldbus1 and the Fieldbus2 icon will be attached to the bridge icon. 
 
 

3.7.6 Disconnecting a Bridge from a Fieldbus 
 
Note the following situation: 
 

 
Figure 3.67. Project Window 

 
A bridge can be disconnected from a fieldbus. 
 
Select the bridge icon, go to the Edit menu and click Disconnect from. Or activate the bridge popup 
menu, right-clicking its icon and selecting the item Disconnect from. 
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Figure 3.68. Disconnect from Fieldbus 

 
The Disconnect Bridge from dialog box will open. Select the fieldbus in the Fieldbus box and click 
Ok. 
 

 
Figure 3.69. Disconnect Bridge Dialog Box 

 
The following figure shows the project tree after disconnection: 
 

 
Figure 3.70. Project Window 

 
The Fieldbus2 icon will no longer be attached to the bridge icon. 
 
 

3.7.7 Bridge Exchange 
 
The procedure to exchange a bridge is the same as described in section 0  
 
Device Exchange. 
 
Please refer to this section for further information. 
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3.8 Function Blocks 

3.8.1 Creating Blocks in the Control Module 
 
To create a Function Block, select the control module icon on the Process Cell window, go to the 
Edit menu and click New Block. Or activate the control module popup menu, right-clicking its icon 
and selecting the item New Block: 
 

 
Figure 3.71. New Block 

 
The New Block dialog box will open: 
 
1. Select a Block Manufacturer from the list. 

2. Select a Device Type provided by the manufacturer that has been selected. 

3. Select the Device Revision. 

4. Select the DD Revision. 

5. Select the CF Revision. 

6. Select a Block Type. 

7. Type a related tag for the block. 

8. Click OK. 
 

 
Figure 3.72. Function Block Dialog Box 

 
 

NOTE 
If a new tag is not typed, the tag will be generated according to the Preferences Settings of the 
current configuration. 
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SYSCON uses the latest revision of the Device Revision, the DD Revision and the CF Revision as 
the default values for the new block. Change these values according to the device being used in the 
plant and its revision. 
 
The Process Cell window will look like the figure below: 
 

 
Figure 3.73. Process Cell Window 

 

3.8.2 Creating Blocks in the Device 
 
To create a block when at least one device has already been added to the configuration, click the 
device expansion sign, , and select the FB icon. Go to the Edit menu and click New Block. Or 
activate the FB popup menu, right-clicking its icon and selecting the item New Block. 
 

 
Figure 3.74. New Block 

 
The New Block dialog box will open: 
 
1. Select a block type. 

2. Type a related tag for the block. 

3. Click OK. 
 

 
Figure 3.75. Function Block Dialog Box 

 



Fieldbus Configuration 
 

3.31 

 
NOTE 

If a new tag is not typed, the tag will be generated according to the Preferences Settings of the 
current configuration. 

 
 
The Fieldbus window should look like the figure below: 
 

 
Figure 3.76. Fieldbus Window 

 
NOTE 

The Resource Block and the Transducer Blocks can only be created in the devices or bridges, 
and they have a different representation from the other blocks. Resource and Transducer Blocks 
cannot be moved or attached to the control module or the Strategy window. 
When converting a configuration file from an older version, the Resource and Transducer Blocks 
will be deleted from the control module and the Strategy window. 

 
 

3.8.3 Changing Block Attributes 
 
The only block attribute that can be changed is the tag. 
 
To change the block tag, select the block icon, go to the Edit menu and click Attributes. Or activate 
the block popup menu, right-clicking its icon and selecting the item Attributes: 
 

 
Figure 3.77. Function Block Attributes 

 
The Block Attributes dialog box will open. 
 
Type the new block tag and click OK. 
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Figure 3.78. Function Block Attributes Dialog Box 

 

3.8.4 Deleting Blocks 
 
To remove a block from the project, select its icon, go to the Edit menu and click Delete Block. Or 
activate the block popup menu, right-clicking its icon and selecting the item Delete Block. 
 

 
Figure 3.79. Deleting the Function Block 

 
A quick way of removing a block is to select its icon on the Process Cell window and press the 
Delete key, on the keyboard. 
 
The Warning dialog box will open. To confirm the deletion, click Yes. 
 

 
Figure 3.80. Confirm Deletion Dialog Box 

 
 

NOTE 
When deleting a block, it will be deleted from the project, even if it is attached to a fieldbus or 
drawn at the Strategy window. The block will be sent to the Recycle Bin, and can be restored to 
the project if its original fieldbus or control module are not deleted. 

 
 



Fieldbus Configuration 
 

3.33 

3.8.5 Attaching Blocks to the Control Module 
 
If at least one block has been added to a device, that block can be attached to the control module. 
 
On the Process Cell window, select the control module icon and attach the block. Go to the Edit 
menu and click Attach Block or activate the control module popup menu, right-clicking its icon and 
selecting the item Attach Block: 
 

 
Figure 3.81. Attaching Block 

 
The Attach Block dialog box will open. Click the down arrow to select the block that will be attached 
and click OK to add the block to the control module: 
 

 
Figure 3.82. Attach Block Dialog Box 

 
 

3.8.6 Detaching Blocks from the Control Module 
 
A block can be only detached if it exists in the control module and in the device. 
 
When detaching the block, it is removed only from the control module. The block will still be 
attached to the device. 
 
On the Process Cell window, select the block icon to be detached. Go to the Edit menu and click 
Detach Block or activate the block popup menu, right-clicking its icon and selecting the item Detach 
Block: 
 

 
Figure 3.83. Detaching Block 
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The Warning dialog box will open. Click Yes to detach the block. 
 

 
Figure 3.84. Detach Block Dialog Box 

 
The block is removed from the control module but it still exists on the project, attached to the device. 
 
 

3.8.7 Attaching Blocks to the Device 
 
If at least one block has been added to the control module, that block can be attached to the device. 
 
On the Fieldbus window, select the FB icon to be attached to the block. Go to the Edit menu and 
click Attach Block or activate the FB popup menu, right-clicking its icon and selecting the item Attach 
Block. 
 

 
Figure 3.85. Attach Block 

 
The Attach Block dialog box will open. Click the down arrow to select the block to be attached. Click 
OK to add the block to the device: 
 

 
Figure 3.86. Attach Block Dialog Box 

 
A message box will alert the user if the block being attached is not compliant with the target device. 
The user should search for a compatible block by clicking the button Yes. The Block dialog box will 
open: 
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Figure 3.87. Selecting a Compliant Block 

 
1. Click the option Show Compliant With Blocks to display the list of compatible blocks types in 

the target device. 
OR 
Click the option Show All Available Blocks to display the list of all blocks types available for 
the target device. 

 
2. Select the block type. 
 
3. Click Ok to accept the changes. 

OR 
Click Cancel to abort this operation and the block will not be attached. 

 
4. If the user clicked Ok, the Deviation dialog box will open so the user can analyze the differences 
 between the original block and the new block. See the example below: 
 

 
Figure 3.88. Block Deviations Dialog Box 

 
5. To accept the changes, click Ok. 

OR 
Click Cancel to discard the changes and cancel the Attach Block procedure. 

 
 

3.8.8 Detaching Blocks from the Device 
 
A block can only be detached if it exists in the control module and in the device. 
 
When the block is detached, it is removed from the device. The block will still be attached to the 
control module. 
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On the Fieldbus window, select the block icon to be detached. Go to the Edit menu and click Detach 
Block. Or activate the block popup menu, right-clicking its icon and selecting the item Detach Block. 
 

 
Figure 3.89. Detach Block 

 
The Warning dialog box will open. If the block is to be detached, click Yes. 
 

 
Figure 3.90. Detach Block Dialog Box 

 
The block is removed from the device but it still exists on the project, attached to the control module. 
 
 

3.8.9 Moving Blocks 
 
The user can drag a block from one control module to another, or from one device to another, in the 
same Process Cell or Fieldbus window or between different windows. 
 
Observe the following example: 
 
1. Click and hold the block icon. 

2. Drag it to the control module where it will be placed. 

 
Figure 3.91. Dragging Blocks to the Control Module 

 
3. The block will be attached to the other control module. Observe the following figure: 
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Figure 3.92. Process Cell Window 

 
Before dragging a block from one window to the other, remember to tile the windows to facilitate the 
process. In the Window menu, click Tile. 
 

NOTE 
When a block is moved between control modules or devices, its tag will be updated according to 
the Preferences set by the user. To prevent undesired changes, select the option Default for the 
automatic block tag generation in the Preferences dialog box. 

 
If the block is moved to a device of a different type or with a different Device Revision, this block 
may not be available in the target device. In this case, a message box will open alerting the user to 
search for a compatible block. Click Yes to open the Block dialog box: 
 

 
Figure 3.93. Selecting a Compliant Block 

 
1. Click the option Show Compliant With Blocks to display the list of compatible blocks types in 

the target device. 
OR 
Click the option Show All Available Blocks to display the list of all blocks types available for 
the target device. 

 
2. Select the block type. 
 
3. Click Ok to accept the changes. 

OR 
Click Cancel to abort this operation and the block will not be moved. 

 
4. The Deviation dialog box will open so the user can analyze the differences between the original 
 block and the new block. 
 
5. To accept the changes, click Ok. 

OR 
Click Cancel to discard the changes and cancel the procedure. 
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3.8.10 Block Off Line Characterization 
 
Select the block to be parameterized by clicking its icon. Go to the Edit menu and click Off Line 
Characterization. Or activate the block popup menu, right-clicking its icon and selecting the item Off 
Line Characterization. 
 

 
Figure 3.94. Block Off Line Characterization 

 
Double-clicking the block icon also activates the Block Characterization dialog box. 
 
In any case, the following dialog box will open: 
 

 
Figure 3.95. Off Line Characterization Dialog Box 

 
The user can sort the parameters list by clicking on a column at the Block Characterization dialog 
box (Parameter, Offset or Handling columns). Clicking the column header will toggle between 
ascendant or descendent sorting. 
 
Select a parameter by clicking its line on the table. Click Edit or click the Value column in front of the 
parameter. 
 
After editing the Value column, click End Edit to confirm the changes on the parameter. If the values 
edited into the parameter are incorrect or don’t have to be changed, click Cancel Edit and they will 
go back to default. 
 
See the figure below: 
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Figure 3.96. Editing Parameter Values 

 
Click Clear to clear the value typed for the highlighted parameter. If the parameter is not part of a 
link in the Strategy window, it will be removed from the configuration. 
 
After finishing the edits, click Close to exit the Block Characterization dialog box and go back to the 
Process Cell window. 
 
For further information about the parameter from the blocks manufactured by SMAR, please refer to 
the Function Blocks Instruction Manual. 
 
 

3.8.11 Block On Line Characterization 
 
To change the block parameter values directly in the devices, the user will have to proceed with the 
Init Communication command first. (See the section Communication for further information). 
 
If SYSCON is already communicating with the Plant, select the block to be parameterized, go to the 
Communication menu and click On Line Characterization. Or activate the block popup menu, right-
clicking its icon and selecting the item On Line Characterization: 
 

 
Figure 3.97. Block On Line Characterization 

 
The Block Characterization dialog box will open. 
 



SYSCON 6.0 - Users’ Manual 
 

3.40 

 
Figure 3.98. On Line Characterization Dialog Box 

 
All of the parameters will be shown in the On Line Characterization. Use the same procedure 
described for the Off Line Characterization to edit the parameters values. If any parameter is 
altered, it also will be altered in the corresponding device. 
 
The user can sort the parameters list by clicking on a column at the Block Characterization dialog 
box (Parameter, Quality, Changed, Offset or Handling columns). Clicking the column header will 
toggle between ascendant or descendent sorting. 
 
If the user changes the value for the parameters, these parameters will be marked with a V in the 
Changed column. 
 

To save a parameter value that has not been edited, click the Mark to save button, , on the 
Characterization toolbar. The parameter will be marked with a V in the Changed column. Or use the 
Mark to save button to unmark a parameter whose value has been changed but the changes are not 
to be saved. 
 
Click Close to exit the Block Characterization dialog box, and the following dialog box will open: 
 

 
Figure 3.99. Save Parameters Dialog Box 

 
Click Yes to save the changes to the configuration file. 
 
 

3.8.12 Customize Characterization 
 
The user can customize the parameterslist of the Block Characterization dialog box. 
 
Select the block icon, at the Process Cell or Fieldbus window. Got to the Edit menu and click 
Customize Characterization. Or activate the popup menu by right-clicking the block icon. Click the 
item Customize Characterization. 
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Figure 3.100. Customize the Characterization 

 
The Customization dialog box will open. 
 

 
Figure 3.101. Customization Dialog Box 

 
At the Default tab, select the parameters that are shown for the block from the same type as the one 

selected, when the user clicks the Customization by Type (Default) button, , from the 
Characterization toolbar. This customization will affect all project configurations. 
 
At the Type tab, select the parameters that are shown for the block from the same type as the one 

selected, when the user clicks the Customization by Type button, , from the Characterization 
toolbar. This customization will affect just the current configuration. 
 
At the Tag tab, select the parameters that are shown just for the block selected, when the user 

clicks the Customization by Tag button, , from the Characterization toolbar. This customization 
will affect just the current configuration. 
 
The Customization dialog box has four buttons: OK, Cancel, Apply and Help. The OK button 
accepts all changes made on the list of selected parameter and exits the dialog. The Cancel button 
discards all changes made on the list of selected parameter and exits the dialog box. The Apply 
button accepts all changes made on the list of selected parameter but does not exit the dialog 
(therefore canceling from the Customization dialog box will not undo applied changes since those 
changes have already been accepted). 
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3.8.13 Ordering Blocks 

 
NOTE 

The user can define the download sequence, by ordering the devices, the blocks, and the 
parameters at the Fieldbus window. 

 
Select a block icon and drag it over the other block icon. The block selected will be placed above the 
other one on the list. 
 

Mouse Cursor
 

Figure 3.102. Ordering Blocks at the Fieldbus Window 
 
The Fieldbus window should look like the following figure: 
 

 
Figure 3.103. Fieldbus Window 

 

3.9 Parameters 

3.9.1 Ordering Parameters 
 
Block parameters can be ordered at the Process Cell window or at the Fieldbus window. The 
example below describes how to order parameters at the Process Cell window. 
 
Select one parameter icon and drag it over the other parameter icon. The parameter selected first 
will be placed above the second one on the list. See the following figure: 
 

Mouse Cursor

 
Figure 3.104. Ordering Parameters in the Process Cell Window 

 
The Process Cell window will look like the following figure: 
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Figure 3.105. Process Cell Window 

 
The changes made to the parameter list at the Process Cell window will be reflected in the Fieldbus 
window, and vice-versa. 
 
 

3.9.2 Deleting Parameters 
 
To remove a block parameter, select the parameter icon, go to the Edit menu and click Delete 
Parameter. Or activate the parameter popup menu, right-clicking its icon and selecting the item 
Delete Parameter: 
 

 
Figure 3.106. Deleting the Parameter 

 
A quick way of removing a parameter is to select its icon on the Process Cell window and press the 
Delete key, on the keyboard. 
 
The Warning dialog box will open. To confirm the deletion, click Yes. 
 

 
Figure 3.107. Confirm Deletion Dialog Box 
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3.10 Strategies 

3.10.1 Creating Strategies 
 
There will be a Strategy window for every control module created for a process cell. 
 
To initialize a Strategy window, select the control module icon, go to the View menu and click 
Strategy. Or activate the control module popup menu, by right-clicking its icon and selecting the item 
Strategy: 
 

 
Figure 3.108. View the Strategy Window 

 
Double-clicking the control module icon also opens the Strategy window. 
 

 
Figure 3.109. Strategy Window 

 
 

3.10.2 Opening Existing Strategies 
 
If changes have been made on a Strategy window and saved, use the steps described in the section 
above to open the existing Strategy. 
 
Then, the Strategy window should look like the example below: 
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Existing Strategy Window

 
Figure 3.110. Strategy Window 

 
 

3.10.3 Saving Strategies 
 
A Strategy can be saved after modifying the drawing area, for example, adding a block. 
 
To save a Strategy window, go to the Project File menu and click Save, as the following figure 
shows: 
 

 
Figure 3.111. Project File Menu: Save Strategy 

 

Or click the Save button, , on the General Operation toolbar, under the Menu bar. 
 
Anytime the drawing is changed, do not forget to save it. 
 
 

3.10.4 Closing and Exiting Strategies 
 
As the Strategy window is not an independent one, there is no exiting command. To close it, go to 
the Project File menu and click Close (since the focus is on this window), as the figure shows: 
 

 
Figure 3.112. Project File Menu: Close Strategy 

 
Or click the Close button, , on the upper right corner of the Strategy window. 
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3.10.5 Importing Templates into the Strategy Window 

 
Double-click the control module icon to open the Strategy window. Click the Import Strategy 

Template button, , on the Strategy toolbar. 
 
If the Strategy toolbar is not open, go to the Tools menu, item Strategy, and click the option Import 
Strategy Template, as indicated in the following figure: 
 

 
Figure 3.113. Tools Menu: Strategy Options 

 
The Open dialog box will open: 
 
1. In the Look in box, select the folder that contains the desired Template file. 

2. Click the template file icon or type its name in the File name box. 

3. Click Open to conclude this task. 
 
See the following figure: 
 

 
Figure 3.114. Open Strategy Template Dialog Box 

 
The template drawing will be added to the Strategy window. The user will be asked to confirm if the 
template is to be imported to the Strategy. See the example below: 
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Figure 3.115. Importing a Template File 

 
Click Ok to import the template to the Strategy window. 
 
The Tag Table dialog box will open, showing a list with the new block tags, based on the 
preferences settings, and the old block tags, used in the template file. 
 

 
Figure 3.116. Tag Table Dialog Box 

 
To edit a tag, right-click the block icon at the New Tag column and click Rename. Type the new tag 
and click Enter on the keyboard. 
 
Click Ok to close the Tag Table dialog box and add the Strategy to the configuration. 
 
The blocks, links and parameters will be attached to the corresponding control module. 
 



SYSCON 6.0 - Users’ Manual 
 

3.48 

 
Figure 3.117. Example of a Strategy Attached to the Control Module 

 
NOTE 

From SYSCON version 5.20 on, a block created or imported from a template file in the Strategy 
window is automatically attached to the corresponding control module. 
If the user is opening a configuration file from a previous version of SYSCON and this file contains 
block templates in the Strategy, these blocks will appear in the Strategy window but will not be 
attached to the control module. Right-click the block in the Strategy window and select the option 
Attach to Model. 

 
 

3.10.6 Exporting Templates from the Strategy Window 
 
Select a ready Strategy, or part of it, and save it as a Template file. 
 
In order to do this, select the blocks and the links that will be part of the template. Observe the 
following diagram: 
 

Selected
Objects

 
Figure 3.118. Selecting Blocks and Links 

 

Click the Export Selected Strategy as Template button, , on the Strategy toolbar. The Save As 
dialog box will open: 
 
1. Choose the folder where the template will be saved. We suggest saving the template file in the 
 folder Template. 

2. Type the name for the template in the File Name box. 

3. Click Save. 
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See the following figure: 
 

 
Figure 3.119. Save As Dialog Box 

 
The Strategy selected will be saved in a file and it can be used at another time in another project 
configuration. 
 

3.10.7 Adding Blocks to the Strategy 
 
There are three ways of adding blocks to the Strategy window: 

a) Dragging Blocks 
Once all blocks have been added to the control module or the device, the user can drag them to the 
Strategy window to start the linking process. 
 
In this case, the user will work with at least two different windows: for example, the Process Cell 
window and the Strategy window. To organize the windows and make them easy to be used, the 
user can display the windows side by side: go to the Window menu, click Tile, and it will organize 
the opened windows inside the application. 
 
If more than three windows are opened remember that some can be minimized and the user can tile 
just the windows being worked with. 
 

 
Figure 3.120. Window Menu: Tile 

 
Now, click and select the block icon and drag it to where it will be placed in the Strategy window 
drawing area. Observe the following diagram: 
 

Selected Block

 
Figure 3.121. Dragging Blocks to the Strategy Window 
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NOTE 

If the block is dropped very close to one already added to the Strategy window, the block will not 
be drawn. It will be necessary to move the blocks in order to organize the project, after they have 
been dropped in the Strategy window. Look for details in the following sections. 

 
The figure below is an example of two dragged blocks inside the Strategy window: 
 

 
Figure 3.122. Blocks inside the Strategy Window 

 
The user can create more than one graphical representation of the block in the Strategy window by 
dragging the block icon, but only one block is attached to the Control Module. 
 
 

b) Creating Blocks in the Strategy Window 
In the previous case, the user already had blocks in the control module or the device. Now, a new 
block will be created in the Strategy window. 
 
First, click on the Strategy window and check the Strategy toolbar to be sure it is open. If it is not, go 
to the Tools menu and point to the item ToolBoxes. The option Strategy should be checked (). 
 
Click the Function Block button, , on the Strategy toolbar. 
 
When the cursor is placed in the Strategy window drawing area, it will turn into a cross. Use the 
cursor to click on the drawing area. 
 
The New Block dialog box will open: 
 
1. Select a Block Manufacturer from the list. 

2. Select a Device Type provided by the manufacturer that has been selected. 

3. Select the Device Revision. 

4. Select the DD Revision. 

5. Select the CF Revision. 

6. Select a Block Type. 

7. Type a related tag for the block. 

8. Click OK. 
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Figure 3.123. New Block Dialog Box 

 
The new block will be drawn in the Strategy window and attached to the corresponding control 
module. 
 

 
Figure 3.124. New Block in the Strategy Window 

 
If another block is to be added, from the same Manufacturer and Device Type as the previous one, 
right-click the drawing area. A list of blocks types will open: 
 

Mouse Cursor

 
Figure 3.125. List of Block Types 
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c) Using a Template File 
It is possible to use a ready Strategy, to add blocks to the control module. The user will import a 
template file to the Strategy window. See section 3.10.5 Importing Templates into the Strategy 
Window for detailed information. 
 
 

3.10.8 Removing Blocks from the Strategy 
 
Be very careful when removing a block from the Strategy window! The user can remove the block 
only from the Strategy window, or the block from the project. 
 

Click the Select button, , on the Strategy toolbar, and select the block to be removed, in the 
Strategy window. More than one block can be selected. 
 
Right-click the block and select Delete from the menu: 
 

 
Figure 3.126. Deleting a Block 

 
Or press the Delete key, on the keyboard. 
 
The Function Block Deletion dialog box will open. If more than one block is selected, a dialog box 
will open to confirm the deletion of each block. Observe the following figure: 
 

Selected
Block

 
Figure 3.127. Function Block Deletion 

 
Click Yes to remove the block from the project. Attention: clicking this button will remove the block 
from the Strategy window, from the control module and from the device. Therefore, the user will lose 
the block parameters and links. The block will no longer exist in the project. 
 
In case the user wants to remove the block only from the Strategy window, click No. Later, the user 
can drag the block again and restore links. (See the section Restoring Links) 
 
If the block is not to be deleted, click Cancel. 
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3.10.9 Selecting Objects at the Strategy Window 

 

a) Selecting One Object 
To select only one object in the Strategy window, click the Select button, , on the Strategy 
toolbar, then click on the object. 
 

Mouse Cursor  
Figure 3.128. Selecting One Object 

 

b) Selecting a Group of Objects 
To select two or more objects in the Strategy window, there are two options: 
 

• Click the Select button, , on the Strategy toolbar and click on one object. Press and hold the 
 Shift key, on the keyboard, then click each object to be selected. 

• Or click anywhere in the blank area of the Strategy window. While dragging the mouse, a rubber 
 band appears around the objects selected. 
 

Mouse Cursor

Starting Point

 
Figure 3.129. Selecting a Group of Objects 

 

c) Selecting All Objects 
To select all objects drawn in the Strategy window, go to the Edit menu and click Select All. Or use 
Ctrl+A, on the keyboard, to select the entire drawing area. 
 
 

3.10.10 Changing Blocks Appearances 
 

Changing the Block Tag 
It is possible to change the block tag in the Strategy window. The new tag will automatically be 
changed in the Process Cell window. 
 
Follow these steps to change the block tag: 
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1. Click the Strategy Modify button, , on the Strategy toolbar. 

2. The mouse cursor will turn into a cross. Click on the block label. 

3. Type a new tag for the block. 

4. Click the drawing area to finish this procedure. 

 
Observe the following diagram: 
 

Mouse Cursor
 

Figure 3.130. Changing Block Tag 
 
 

Changing Block Dimension Attributes 
It is possible to make a block have its height equal to its width: 
 
1. Click the Select button, on the Strategy toolbar. 

2. Select the block. 

3. Right-click on it and the popup menu will open. 

4. Click the option Same Width and Height. 

 
See the following figure: 
 

 
Figure 3.131. Block Popup Menu: Same Width and Height 

 
The block will be changed as this diagram shows: 
 

 
Figure 3.132. Changing Block Dimension 
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Showing Block Types 
When a block is added to the Strategy window, the object only shows the block tag. 
 
To show the block type: 
 
1. Select the block in the Strategy window. 

2. Right-click on it. 

3. Click on the option Show Info. 
 
See the following diagram: 
 

 
 

Figure 3.133. Block Popup Menu: Show Info 
 
When completed, the block will appear as the following: 
 

 
Figure 3.134. Showing Block Type 

 

Changing Block Properties 
Right-click any block. The popup menu will open. Click the option Properties, as indicated below: 
 

 
Figure 3.135. Block Popup Menu: Properties 

 
The following dialog box will open: 
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Figure 3.136. Object Properties Dialog Box 

 
In each tab, the user can change different properties. For example, the line color can be changed at 
the Line tab, item Color, and the fill color can be changed at the Fill tab, item Color: 
 

 
Figure 3.137. Changing Block Properties 

 
 

Changing the Block Default Format 
When a block is added to the Strategy window, an ellipse (more exactly a circle) containing the 
block tag will represent it. 
 
To change this representation, go to the Option menu and point to the item Function Block Icon. 
Select a new format, as indicated in the figure below: 
 

 
Figure 3.138. Options Menu: Function Block Icon 

 
 
The next figure shows the different block formats: 
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Ellipses Rectangles Rounded
Rectangles

 
Figure 3.139. Block Formats 

 
 

3.10.11 Links 

Creating Links 
Blocks can only be linked inside the Strategy window. 
 

To link one block to another, click the Link button, , on the Strategy toolbar, and click on the 
block. 
 

Mouse Cursor  
Figure 3.140. Linking Blocks - Output Parameter 

 
The Output Parameter Selection dialog box will open: 
 

 
Figure 3.141. Output Parameter Selection Dialog Box 

 
When the cursor is placed over the OUT Parameter, a short explanation can be read, at the 
Parameter Description text box. Click on the OUT Parameter to select it then click OK. 
 
Return to the Strategy window, and the cursor will draw a line to represent the link. Place the mouse 
over the target block and click on it. 
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Mouse Cursor
 

Figure 3.142. Linking Blocks - Input Parameter 
 
The Input Parameter Selection dialog box will open: 
 

 
Figure 3.143. Input Parameter Selection Dialog Box 

 
When the cursor is placed on an Input Parameter, the user will read a short explanation about it, at 
the Parameter Description text box. Select the Input Parameter by clicking on it then click OK. 
 
The link will automatically be drawn: 
 

 
Figure 3.144. Linked Blocks 

 

Fast Link Process 
It is possible to make links without opening the Selection dialog box. 
 

With the Link button selected, , on the Strategy toolbar, right-click the block. The Parameters List 
will open. Click the item OUT that represents the OUT Parameter: 
 

 
Figure 3.145. Fast Link - Output Parameter 

 
Drag the cursor to the target block and right-click on it. The popup menu will open. Select the Input 
Parameter wanted by clicking the corresponding item. See the following diagram: 
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Figure 3.146. Fast Link - Input Parameter 

 
See the following example of linked block into a Cascade Control design: 
 

 
Figure 3.147. Cascade Control Example 

 
 

Link Attributes 
A link has several attributes, and can be changed. Use the Select Button, , on the Strategy 
toolbar, to select a link. Right-click on the link to activate its popup menu. 
 
On the Labels submenu, there are three options: 
 
• Show Link Label: shows the link label if the option has been checked. 

• Show Output Parameter: shows the Link Output Parameter label if the option has been 
 checked. 

• Show Input Parameter: shows the Link Input Parameter label if the option has been checked. 

 
The following figure indicates the Labels submenu options: 
 

 
Figure 3.148. Labels Menu 

 
On the Reference Point submenu, select the reference point for the Modifying tool. There are three 
options: 
 
• Ref. On Current Point: the selected handle is the reference itself. 

• Ref. On Previous Point: the selected handle will be placed based on the position of the previous 
 handle. 

• Ref. On Next Point: the selected handle will be placed based on the position of the next handle. 
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The following figure indicates the Reference Point submenu options: 
 

 
Figure 3.149. Reference Point Menu 

 
When clicking the item Properties, the Object Properties dialog box will open. The user can change 
the line and fill colors, for example. 
 

Removing Links 

To remove a link from the Strategy window, select the link using the Select button, , on the 
Strategy toolbar. Right-click the link and select the option Delete. 
 

 
Figure 3.150. Link Menu: Delete 

 
Or press the Delete key, on the keyboard. The Link Deletion dialog box will open: 
 

Selected
Link

 
Figure 3.151. Link Deletion Dialog Box 

 
Be careful! Clicking Yes will remove the link and parameters from the drawing area and also from 
the project. The link will no longer exist in the control module or in the device. 
 
Click No to remove the link only from the drawing area. In this case, it can be restored later if 
necessary. (Section Restoring Links) 
 
If it is not to be removed, click Cancel. 
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Restoring Links 
Consider the following Strategy: 

 
Figure 3.152. Example of Control Strategy 

 
As can be seen, this Strategy has two Feedback links: one from the Block3 to the Block2 and the 
second link from the Block2 to itself. 
 
Suppose they were deleted from the Strategy window only. 
 
To restore those links, follow these steps: 
 
1. Select the block that had its link deleted. 

2. Activate the block popup menu, by right-clicking on it. 

3. Click the item Show Hidden Links. 
 
See the following diagram: 
 

 
 

Figure 3.153. Block Popup Menu: Show Hidden Links 
 
After being restored, the links will not be shown in their previous positions. 
 
They will look like the links in the following figure: 
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Figure 3.154. Restored Links 

 
See the section Redrawing Links to understand how the links can be redrawn as they were before. 
 
 

Redrawing Links 
A link line can be redrawn by dragging the modifying handles in the drawing area, creating a new 
handle or removing a handle. 
 
To create a new modifying handle, click on the link line. To remove a modifying handle, right-click on 
the handle. 
 
Consider the following Strategy: 
 

 
Figure 3.155. Another Example of Control Strategy 

 
To redraw the link from Block2 to Block1, as in the example above, follow these steps: 
 

1. Use the Select Button, , on the Strategy toolbar, to select the link line. 

2. Click the Modify button, , on the Strategy toolbar, and the modifying handles will appear. 

3. Click on the link line to create a new modifying handle. See the diagram: 
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New Modifying
Handle

 
Figure 3.156. Modify Handle Tool 

 
4. Click on a handle and drag it over the drawing area to redraw the link. 

 
According to the reference point, hold the Ctrl key down while dragging the handle to draw a 
horizontal or vertical line from the reference handle. Or hold the Shift key down while dragging the 
handle to draw diagonal line from the reference handle. 
 
See in the following figure the new link: 
 

 
Figure 3.157. Redrawn Links 
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Section 4 
 

4.1 

4 Recycle Bin 
 
The items that were sent to the Recycle Bin can be recovered at any time, even if the configuration 
is closed and opened again. 
 
To open the Recycle Bin window, right-click its icon at the Project window and click Expand: 
 

 
Figure 4.1. Opening the Recycle Bin Window 

 
Devices and blocks are identified by their original configuration attributes, such as tags, IDs or 

control modules. Click the Show/Hide Details button, , on the General Operation toolbar, to 
display the detailed information about the devices, blocks and parameters. 
 

 
Figure 4.2. Recycle Bin Window 

 
It is also possible to check the attributes of the selected item by right-clicking its icon and selecting 
Attributes from the popup menu. 
 

 
Figure 4.3. Opening the Attributes Dialog Box 

 
The Attributes dialog box will display all the information about the block or device selected. 
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4.1 Restoring Devices and Blocks 
 
To restore a bridge, device or block to the configuration, right-click the icon at the Recycle Bin 
window and click Restore. 
 

 
Figure 4.4. Restoring a Bridge 

 
The selected device or block, and all of its contained information, will be restored to the 
configuration and attached to its original fieldbus or control module. 
 

NOTE 
If the fieldbus or the control module where the device or block was attached is removed, it will not 
be possible to restored the item. 

 
If the restored item has a duplicated tag, the Tag Table dialog box will open and the new tag of the 
item will be generated based on the preference set by the user. 
 
To edit the tag, right-click the icon of the item at the New Tag column and then click Rename. Type 
the new tag and click Enter on the keyboard. 
 
 

4.2 Deleting Items from the Recycle Bin 
 
When an item is deleted from the Recycle Bin, it is completely removed from the configuration and 
cannot be restored later on. 
 
To remove a block or device from the Recycle Bin window, right-click its icon and click Delete. 
 

 
Figure 4.5. Deleting a Block from the Recycle Bin window 

 
To empty the Recycle Bin, go to the Edit menu and click Empty Recycle Bin. Or right-click the 
Recycle Bin icon and click the option Empty Recycle Bin. 
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Figure 4.6. Deleting all elements from the Recycle Bin 

 
All of the items in the Recycle Bin will be deleted. 
 
 

4.3 Ordering Items in the Recycle Bin Window 
 
The items in the Recycle Bin window can be ordered by the date and and time they've been deleted, 
by the tag or by the type of the items. 
 
Right-click the Recycle Bin icon at the Recycle Bin window and select one of the options as 
indicated in the figure below: 
 

 
Figure 4.7. Ordering Items in the Recycle Bin Window 

 
Sort by deletion time: elect this option to order the blocks, devices and bridges based on the date 
and time they have been deleted from the configuration. 
 
Sort by item type: elect this option to order the blocks, devices and bridges alphabetically based on 
the type of the items. 
 
Sort by item tag: elect this option to order the blocks, devices and bridges alphabetically based on 
the tag of the items. 
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Section 5 
 

5.1 

5 Templates 
 
It is possible to use a ready Strategy or part of it, in another project file or even in another process 
cell. It is necessary to create a template file from a Strategy Configuration. After which, just import 
the template into the control module, change the tags and assign the blocks to the devices. 
 
SYSCON 6.0 also creates Device Templates. This feature allows the user to create a device or 
bridge template, attaching blocks and configuring parameters. The user can open the device 
template file and the project file at the same time, and then attach the devices or blocks to the 
configuration by dragging them to the desired fieldbus channel. 
 
Using templates can speed up the development work tremendously. This will make it very 
productive at the same time as the boring repetitive work is eliminated. Engineering time and costs 
are reduced. 
 
At the same time the configurations become more consistent and neater looking, and therefore 
easier to troubleshoot. Pre-configured templates also eliminate many chances of mistakes. The 
tedious process of instantiating block after block, and the agony of that forgotten parameter is a 
thing of the past. 
 

5.1 Creating Templates 
 

To create a template file, go to the Project File menu and click New. Or click the New button, , 
on the General Operation toolbar. 
 
The Document Type box will open. Select the desired template: Strategy, Device or Bridge. 
 

 
Figure 5.1. Select the Template Type 

 

5.2 Opening Template Files 
 
To open an existing template, go to the Project File menu and click Open, or click the Open button, 

, on the General Operations toolbar. 
 
The Open dialog box will open: 
 
1. In the Look in box, select the folder that contains the template file to be opened. 

2. In the Files of type box, select the template type. The files *.fft are Strategy Templates; the files 
 .dtp are Device Templates and the files *.btp are Bridge Templates. 

3. Click the template file icon or type its name in the File name box. 

4. Click Open to conclude this task. 
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See the following example: 
 

 
Figure 5.2. Open Template Dialog Box 

 
 

5.3 Opening the Default Template 
 
To open the device or bridge default template, go to the Project File menu and click Open Default 
Template. 
 

 
Figure 5.3. Opening the Default Template 

 
The Open Default Template dialog box will appear: 
 

 
Figure 5.4. Open Default Template Dialog Box 

 
1. Choose the Manufacturer from the list. 

2. Select the device type. 

3. Select the Device Revision. 

4. Click Ok. 
 
The Template window will open. See the example below: 
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Figure 5.5. Device Template Window 

 

5.4 Saving Templates 
 

To save the template, go to the Project File menu and click Save, or click the Save button, , on 
the General Operations toolbar. 
 
The Save As dialog box will open: 
 
1. Choose the folder where the template will be saved. There is a folder named Templates, inside 

the Syscon folder. We suggest that all template files saved should be in this folder. Double-click 
the Templates folder to open it. 

2. Type the name for the template in the File name box. 

3. Click Save. 
 
See the following example: 
 

 
Figure 5.6. Save As Dialog Box 

 
Anytime a change is made to the template drawing, do not forget to save it. 
 
 

5.5 Saving the Default Template 
 
To save the device or bridge template as the Default Template, go to the Project File menu and click 
Save As Default Template. 
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Figure 5.7. Saving the Default Template 

 
The Default Template file is located in the Device Support folder of the Device manufacturer. The 
name of the template file is composed by the Device Revision number (2-digits hexadecimal 
number) and the extension dtp for devices and btp for bridges. 
 
 

5.6 Closing Templates 
 
To close the template, click on its window, in case the focus is on another application window, go to 
the Project File menu and click Close, or click on the Close button, , in the upper right corner of 
the Template window. 
 
Do not forget to save the template before closing it. 
 
 

5.7 Editing Strategy Templates 
 
The Strategy Template window has the same properties as in the Strategy window. The user can 
draw blocks and links, and can also configure block attributes. The only difference is that the blocks 
will not be attached to a control module or a device. 

5.7.1 Creating Blocks 
 
To add blocks to the template, click the Function Block Template button, , on the Strategy 
toolbar. Click the drawing area and the New Block dialog box will open: 
 
1. Select a Block Manufacturer from the list. 

2. Select a Device Type provided by the manufacturer that has been selected. 

3. Select the Device Revision, the DD Revision and the CF Revision. 

4. Select a block type and type a related tag for the blocks. 

5. Click OK. 
 
 

5.7.2 Changing Block Attributes 
 
The user can change block tags, typing names related to the block type or function. 
 

Click the Strategy Modify button, , on the Strategy toolbar and then click on the block label. Type 
a new tag for the block and click the drawing area to conclude. 
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5.7.3 Block Characterization 
 
To configure the block parameters, right-click the block icon in the drawing area and select the 
option Off-line Characterization. The Characterization window will open. 
 
See section 3.8.10 Block Off-line Characterization for details. 
 
 

5.7.4 Creating Links 
 

To link one block to another, click the Link button, , on the Strategy toolbar. Right-click the block 
and select the Output Parameter from the popup menu. Drag the cursor to the target block, right-
click it and select the Input Parameter from the popup menu. 
 
See section 3.10.11 Links for details. 
 
 

5.8 Editing Device and Bridge Templates 
 
A Device Template contains one device and the corresponding Resource and Transducer Blocks. 
The user can add or remove blocks and configure the block parameters. 
 
The sub-sections below are related to the device template. The bridge is a device with specific 
characteristics, so the following instructions should be used to create the Bridge Template. 
 
The Device Template files are those with the extension dtp and the Bridge Templates are those with 
the extension btp. 

5.8.1 Creating Devices 
 
When the user creates a new device template, the New Device dialog box automatically open: 
 
1. Select a Device Manufacturer from the list. 

2. Select the Device Type. 

3. Select the Device Revision. 

4. Select the DD Revision and the CF Revision, or check the option Follow the Latest DD/CF 
Revision to apply the latest revision for the selected device. 

 
NOTE 

If the option Follow the Latest DD/CF Revision is selected, SYSCON will update the device with 
the latest revision of the DD and CF everytime the template file is opened or imported to a 
configuration. 

5. Type a related tag for the device. 

6. At the Advanced Options tab, select the options to automatically create the Resource and 
 ransducers Blocks. 

7. Click Ok to conclude. 
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Figure 5.8. Device Template Window 

 
 

5.8.2 Changing Attributes 
 
The user can change the tag of the device or bridge in the template file. 
 
Right-click the device icon and select the option Attributes. Type the new tag and click Ok. 
 
 

5.8.3 Creating Blocks 
 
Only the Resource and Transducers Blocks can be added to the device template. Right-click the FB 
VFD icon and select the option New Block. The New Block dialog box will open: 
 
1. Select the block type. 

2. Type a related tag for the block. 

3. Click OK. 
 
If the user doesn't type a tag for the block, SYSCON will combine the device tag with the Block 
mnemonic to generate the new tag. 
 
 

5.8.4 Changing Block Attributes 
 
The user can change block tags, typing names related to the block type or function. 
 
Right-click the block icon and select the option Attributes. The Block Attributes dialog box will open. 
Type a new tag for the block and click Ok. 
 
 

5.8.5 Block Characterization 
 
To configure the block parameters, right-click the block icon and select the option Off-line 
Characterization. The Characterization window will open. 
 
See section 3.8.10 Block Off-line Characterization for details. 
 
 
 
 



Section 6 
 

6.1 

6 Communication 
6.1 Introduction 

 
Once the configuration is completely ready, the user can make SYSCON communicate with the 
plant. 
 
First, it is necessary to remember that a PCI board or a DFI must be included in the project 
configuration. If the user doesn't have a Communication Interface in the project configuration, see 
the section Creating Bridges. Select Smar as the Bridge Manufacturer and select PCI or DFI as the 
Device Type. 
 

NOTE 
SYSCON can detect errors in the server to avoid a crash in the system when operating offline. 
After an error occurs in the server, SYSCON doesn’t go to Offline mode automatically nor abort the 
download operation. The user must terminate the communication and restart it. 

 

6.2 Configuring the Communication 
 
To configure the communication server, select the fieldbus networks icon, go to the Communication 
menu and click Settings. Or activate the popup menu by right-clicking the fieldbus networks icon and 
selecting Communication Settings. See the following figure 
 

 
Figure 6.1. Configuring the Communication 

 
The Communication Settings dialog box will open: 
 

 
Figure 6.2. Initializing Communication 

 
Select the Server ID by clicking on the drop-down menu. If a HSE fieldbus is added to the 
configuration, the HSE OLE Server will be selected when the user clicks the Operation Mode button, 

. 
 
Select the server context and type the name of the server node. Click Ok to conclude. 
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6.3 Initializing the Communication 
 

To initialize the communication, click the Operation Mode button, , on the General Operation 
toolbar under the Menu bar. 
 
The video clip below should appear for a few seconds. During this time, SYSCON will identify and 
attach any bridge and fieldbus to the real plant. 
 

 
Figure 6.3. Initializing Communication 

 
Next, the user will have to change the bridge attributes. Select the bridge ID from the Device ID list 
and choose the tag related to the bridge. (See the section Changing Bridge Attributes for further 
information.) 
 

NOTE 
Once the bridge attributes match the installed bridge attributes, this step will no longer be 
necessary. SYSCON will automatically do the association. 

 
When the Fieldbus window is opened, the following video clip should appear for a few seconds: 
 

 
Figure 6.4. Initializing the Communication 

 
The user can check the devices communicating on the channel. Click on the fieldbus icon, go to the 
View menu and click Live List. The user can also right-click the fieldbus icon to activate its popup 
menu and select the item Live List. 
 

 
Figure 6.5. Live List Request 

 
Each fieldbus has its own Live List. See section 6.9 Live List. 
 
 

6.4 Associating Devices' IDs 
 
After initializing the communication with the fieldbuses, it is necessary to associate the devices that 
are configured in the project to the devices in the Live List. 
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Open the Device dialog box to change its attributes and select the Device ID from the list. (See the 
section Changing Device Attributes for further information) 
 
Repeat this procedure for each device in every fieldbus, if the device hasn't been associated as yet. 
 
 

NOTE 
Once the device tag or the device ID matches any node in the Live List, SYSCON will 
automatically do the association. 

 
 

6.5 Tags Assignment 
 
In the previous section, one address was automatically assigned to each device. Now, it is 
necessary to assign the tags to each one of these devices and interfaces. 
 
On the Fieldbus window, click on each bridge and device, go to the Communication menu and click 
Assign Tag. The user can also activate the popup menu by right-clicking on their icons and selecting 
Assign Tag. See the following figure: 
 

 
Figure 6.6. Communication Menu: Assign Tag 

 
The tag written in the configuration will be sent to the device, see the following clip: 
 

 
Figure 6.7. Assigning Tags 

 
NOTE 

To make sure that the tag assignment was successful, open the Live List of the fieldbus (or 
segment) and see if the tag from the device is the one that was sent. 

 
 

6.6 Error Log Registry 
 
The Error Log window reports the errors that occurred during the communication. 
 
It is important to clear the Error Log Registry before downloading the configuration, because any 
eventual error that might occur during the download process will be easily detected as the Error Log 
window pops up automatically at the occurrence of its first error. 
 

Click the Error Log button, . It will open the Error Log window. 
 
Right-click inside this window to activate the popup menu and select the option Clear Log. See the 
following figure: 
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Figure 6.8. Error Log Window 

 

6.7 Downloading the Configuration 

6.7.1 Plant Configuration Download 
 
Since the communication at the fieldbus networks has been initialized by clicking the Operation 
Mode button, it is time to download the configuration. 
 
In the Project window, click the fieldbus networks icon, go to the Communication menu and click the 
item Download. Or right-click the fieldbus networks icon and select the item Download. 
 

 
Figure 6.9. Plant Download 

 
The Download dialog box will open. To download the entire configuration to the plant, do not select 
the option Incremental download and click Start. 
 

 
Figure 6.10. Downloading the Plant Configuration 

 
If the option Incremental download is selected, SYSCON will compare the project configuration with 
the plant configuration. 
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The option Compare parameters will force SYSCON to evaluate the parameters in the devices, 
comparing parameters in the plant configuration to the parameters in the project configuration. If the 
user do not select this option, the values of the parameters won't be compared and will be 
downloaded unconditionally. That means the parameters that already exist in the device will be 
overwritten! 
 
The message box in the figure below will appear if there is any difference in the configuration. 
 

 
Figure 6.11. Checking the Plant Configuration 

 
Click Yes to open the Incremental Download dialog box and check the differences. 
 

 
Figure 6.12. Incremental Download Dialog Box 

 
Click Ok to download the configuration. 
 

6.7.2 Fieldbus Download 
 
To execute the download for a specific fieldbus segment, click the fieldbus icon, go to the 
Communication menu and click the item Download. Or right-click the fieldbus icon and select the 
item Download. 
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Figure 6.13. Fieldbus Download 

 
The Download dialog box will open. Click Start to download the fieldbus information. 
 

 
Figure 6.14. Downloading the Fieldbus Segment 

 
To execute the incremental download, select the option Incremental download. See section 6.7.5 
Incremental Download for more details. 
 
 

6.7.3 Device Download 
 
In case a device failed or after replacing a device, the user can run a partial download for this 
device, provided that it doesn’t change the configuration. When the configuration is changed, it's up 
to the user to run a partial download for all devices affected by the change. Otherwise, the partial 
download can produce unpredictable results. 
 
Note that changes in one device may affect others. If the user changes an external link for instance, 
it is affecting at least two devices besides the LAS. 
 
The partial download speeds up the download process. However, in case of doubts, it is strongly 
recommended using the complete download. 
 
In the Fieldbus window, click the device icon, go to the Communication menu and click the item 
Update. Or right-click the device icon to activate its popup menu and select the item Update. 
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Figure 6.15. Updating the Bridge Information 

 
The replaced device tag will get out of the Live List and the new device tag will appear. Now the 
user can run the download. 
 
In the Fieldbus window, click the device icon, go to the Communication menu and click the item 
Download. Or right-click the device icon to activate its popup menu and select the item Download. 
 

 
Figure 6.16. Device Download 

 
The Download dialog box will open. Click Start to download the device information. 
 

 
Figure 6.17. Downloading the Device 

 
To execute the incremental download, select the option Incremental download. See section 6.7.5 
Incremental Download for details. 
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6.7.4 Bridge Download 
 
Click the bridge icon, go to the Communication menu and click the item Download. Or right-click the 
bridge icon to activate the menu and select the item Download. 
 

 
Figure 6.18. Bridge Download 

 
The Download dialog box will open. 
 

 
Figure 6.19. Downloading the Bridge 

 
If the user selects the option Propagate downstream, SYSCON will run the download for the bridge 
and then propagate the download procedure to the fieldbus segments located below the bridge in 
the topology tree, at the Project window. 
 
To execute the incremental download, select the option Incremental download. See section 6.7.5 
Incremental Download for details. 
 
Click Start to conclude and execute the download. 
 
 

6.7.5 Incremental Download 
 
SYSCON can compare the project configuration with the plant configuration and then execute the 
download only for the discrepant information, without sending unnecessary information to the 
device. 
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The Incremental Download Algorithm executes the download twice: the first download will verify the 
configuration and report the differences. The second download will be executed if the user decides 
to update the information in the plant configuration. 
Blocks and links that exist in the plant configuration but not in the project configuration will be 
deleted in order to preserve the project configuration consistency. 
 
In the Download dialog box, select the option Incremental download to compare the project 
configuration with the plant configuration. 
 
The option Compare parameters will force SYSCON to evaluate the parameters in the devices, 
comparing the parameters in the plant configuration to the parameters in the project configuration. If 
the user do not select this option, the values of the parameters won't be compared and will be 
downloaded unconditionally. That means the parameters that already exist in the device will be 
overwritten! 
 
The message box in the figure below will appear if SYSCON finds any difference in the 
configuration. 
 

 
Figure 6.20. Checking the Differences 

 
• Click Yes to open the Incremental Download dialog box and check the differences. 

• Click No to execute the download without checking the discrepancy between the configurations. 

• Click Cancel to abort the download and return to the project configuration. 
 
The figure below shows the Incremental Download dialog box: 
 

 
Figure 6.21. Incremental Download Dialog Box 
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The panel on the left shows the topology tree. The panel on the right will describe the discrepancies 
for the item selected on the left panel. 
 
The Incremental Download dialog box has its own toolbar. The following table describes the 
functionalities of the buttons: 
 

 Click this button to refresh the information on the dialog box. 

 Click this button to expand all nodes. 

 Click this button to collapse all nodes. 

 Click this button to execute the download and close the Incremental Download dialog box. 

 Click this button to cancel the download and close the Incremental Download dialog box. 

 Click this button to open the SYSCON Help. 

 
The Incremental Download dialog box has four filter levels that classifies all of the blocks and 
parameters attributes for the device: 
 

 
This filter indicates that there are no discrepancies in the configuration and the download 
won't be necessary for the selected device. 

 
The Low Severity filter indicates that there are discrepancies in the configuration and the 
device information will be overwritten. 

 The High Severity filter indicates that the download cannot be executed. 

 This filter will display all of the attributes. 

 
Click the column headers (Description, Configuration or Plant column) on the right panel to sort the 
list of information. Clicking the column header will toggle between ascendant or descendent sorting. 
 
 

6.7.6 Download Schedule 
 
To download the schedule, click the fieldbus icon, go to the Communication menu and click the item 
Download Schedule. Or right-click the fieldbus icon and select the item Download Schedule. 
 

 
Figure 6.22. Download Schedule 

 
The message box will open. Click Yes to download the schedule. 
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Figure 6.23. Confirming the Schedule Download 

 
The schedule can be defined in the Fieldbus Attributes dialog box. See section 3.5.2 Changing 
Fieldbus Attributes for more details. 
 

6.8 Uploading the Configuration 

6.8.1 Configuration Upload 
 
This section describes the steps to upload the configuration from the field devices to the project file. 
It is necessary to initialize the communication, before executing the upload. 
 
In the Project window, click on the fieldbus networks icon, go to the Communication menu and click 
the item Upload. Or right-click on the fieldbus networks icon to activate its popup menu and select 
the item Upload. 
 

 
Figure 6.24. Upload 

 
The Upload dialog box will open: 
 

 
Figure 6.25. Upload Dialog Box 
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Set the Upload Filters by checking the Topology box, Device List box, Block List box and 
Parameters box. Click the button Start. 
 
The progress bars indicate that SYSCON is reading the information from the fieldbuses and adding 
the devices, blocks and parameters to the configuration file. 
 

NOTE 
At any time during the upload the user can stop this process by clicking Abort in the Upload dialog 
box. 

 
 

6.8.2 Partial Upload 
 
The user can run a partial upload for fieldbuses, devices or blocks by setting the filters properly. 
 

Topology Upload 
Click the fieldbus networks icon, on the Project window, and select Upload from the popup menu. 
On the Upload dialog box, select only the Topology box and click Start. 
 
SYSCON will upload the Topology. 
 

Device Upload 
On the Fieldbus window, click the fieldbus icon and select Upload from the popup menu. On the 
Upload dialog box, select only the Device List box and click Start. 
 
SYSCON will upload the devices for the selected fieldbus. 
 

Block Upload 
On the Fieldbus window, click the device icon and select Upload from the popup menu. On the 
Upload dialog box, select only the Block List box and click Start. 
 
SYSCON will upload the blocks for the selected device. 
 

Parameter Upload 
On the Fieldbus window, click the block icon and select Upload from the popup menu. On the 
Upload dialog box, select only the Parameters box and click Start. 
 
SYSCON will upload the parameters for the selected block. 
 
 

6.9 Live List 
 
The user can view the list of devices instantiated in a fieldbus through the Live List, after the 
communication is initialized. 
 
In the Fieldbus window, click on the fieldbus icon, go to the View menu and click the item Live List. 
Or right-click on the fieldbus icon to activate its popup menu and select the item Live List. 
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Figure 6.26. Opening the Live List window 

 
The Live List window will open: 
 

 
Figure 6.27. Live List Window 

 
The Live List indicates the devices and bridges, identified by the Device Tag, Device ID and Device 
Address, as well as the device configured as the Active LAS. The Active LAS will be indicated with a 
different icon in the Live List. 
 
 

6.9.1 Live List Menu Options 

Assign Tag 
Right-click on the device icon to activate its popup menu and select the item Assign Tag. 
 

 
Figure 6.28. Live List Menu: Assign Tag 

 
The Assign Tag dialog box will open. Type the new tag and click Ok: 
 

 
Figure 6.29. Assign Tag Dialog Box 
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Attributes 
Right-click on the device icon to activate its popup menu and select the item Attributes. 
 

 
Figure 6.30. Live List Menu: Attributes 

 
The Device Attributes dialog box will open. 
 

 
Figure 6.31. Device Attributes Dialog Box 

 

Upload Device 
Right-click on the device icon to activate its popup menu and select the item Upload Device. 
 

 
Figure 6.32. Live List Menu: Upload Device 

 
The following dialog box will open while the device is being uploaded. 
 

 
Figure 6.33. Uploading Device 

 
 

6.10 Block List 
 
The user can view the list of blocks instantiated in a device through the Block List, after the 
communication is initialized. 
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In the Fieldbus window, click on the FB icon, go to the View menu and click the item Block List. Or 
right-click on the FB icon to activate its popup menu and select the item Block List. 
 

 
Figure 6.34. Opening the Block List window 

 
The Block List window will open: 
 

 
Figure 6.35. Block List Window 

 
 

6.10.1 Block List Menu Options 

Assign Tag 
Right-click on the block icon to activate its popup menu and select the item Assign Tag. 
 

 
Figure 6.36. Block List Menu: Assign Tag 

 
The Assign Tag dialog box will open. Type the new tag and click Ok: 
 

 
Figure 6.37. Assign Tag Dialog Box 

 



SYSCON 6.0 - Users’ Manual 
 

6.16 

Attributes 
Right-click on the block icon to activate its popup menu and select the item Attributes. 
 

 
Figure 6.38. Block List Menu: Attributes 

 
The Block Info dialog box will open. 
 

Characterization 
Right-click on the block icon to activate its popup menu and select the item Characterization. 
 

 
Figure 6.39. Block List Menu: Characterization 

 
The Block Characterization dialog box will open: 
 

 
Figure 6.40. Characterization Window 

 
See the section Block On Line Characterization for further information. 
 

Upload Block 
Right-click on the block icon to activate its popup menu and select the item Upload Block. 
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Figure 6.41. Block List Menu: Upload Block 

 
The block will be created in the corresponding device. 
 
 

6.11 Exporting Tags 
 
To enable the on-line communication with the parameters of the function blocks, the user will have 
to generate a file containing all tags (devices and function blocks) present in the configuration. 
 
On the Project window, click on the project icon, go to the Export menu and click Tags. Or activate 
the popup menu by right-clicking on the project icon. Click the item Export Tags. 
 

 
Figure 6.42. Export Menu: Export Tags 

 
The Save Tag Info dialog box will open. Select the Taginfo.ini file and click Save. 
 

 
Figure 6.43. Save Tag Info Dialog Box 

 
 

NOTE 
Every time any tag is changed in the configuration, it is necessary to repeat the Export Tag 
procedure. Otherwise, the supervision of the new tag will not be allowed. 

 
 
In the Preferences dialog box, the user can set the option to automatically export the tags, everytime 
a relevant online procedure requires a tag to be exported. In this case, a message box will open for 
the user to confirm the Export Tag procedure. See section 2.2 Preferences. 
 
To manually update the Taginfo.ini file, click on the project icon, go to the Export menu and click 
Update OPC Database. Or activate the popup menu, right-clicking on the project icon. Click the item 
Update OPC Database. 
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Figure 6.44. Export Menu: Update OPC Database 

 
The file promptly will be updated. 
 
 

NOTE 
If there are two or more configuration files, the tag lists from these sources must be consolidated 
in a single list, so the OPC Server can use the entire list of tags to provide the information 
requested by any OPC client application. 

 
 
The user must assure that the tags used in all of the configuration files are unique. If there are 
duplicated tags, only one tag will be exported to the Taginfo.ini file. 
 
When the user exports the tags or updates the OPC database of a configuration that has a 
consolidated tag list, the consolidated list will be updated with the tag list corresponding to the 
configuration current open. 
 
 

6.12 Exporting the Configuration 
 
The user can export the project configuration to an existing database. 
 
On the Project window, click the project icon. Go to the Export menu and click Configuration. Or 
activate the popup menu, by right-clicking the project icon. Click the item Export Configuration. 
 

 
Figure 6.45. Export Menu: Export Configuration 

 
The Select Data Source dialog box will open. 
 
On the File Data Source tab, select the source that describes the driver that is to be connected. The 
user can use any file data source that refers to an ODBC driver, which is installed on the machine. 
 
Double-click the data source icon to select the driver. See the following figure: 
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Figure 6.46. Select Data Source Dialog Box 

 
Or the user can also use the Machine Data Source tab. 
 
The Machine Data Source is specific to the machine, and cannot be shared. According to the Type 
column: "User" data sources are specific to a user on the machine; "System" data sources can be 
used by all users on the machine, or by a system-wide service. 
 
Double-click the data source name to select the machine. See the following figure: 
 

 
Figure 6.47. Select Data Source Dialog Box 

 
The Select Workbook dialog box will appear: 
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Figure 6.48. Select Workbook Dialog Box 

 
Select the folder where the data file is and double-click the workbook icon. 
 
The project configuration will be saved to the workbook file. 
 
 

6.13 Consolidating the OPC Database 
 
If the user is working with two or more configuration files, the tag lists from these source files must 
be consolidated in a single list. 
 
On the Project window, click on the project icon, go to the Export menu and click Consolidate OPC 
Database. Or activate the popup menu right-clicking on the project icon. Click the item Consolidate 
OPC Database. 
 

 
Figure 6.49. Consolidate OPC Database 

 
The Consolidate OPC Database dialog box will open. 
 

 
Figure 6.50. Consolidate OPC Database dialog box 
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6.13.1 Adding a Configuration 
 
To add the current configuration to the consolidate list, click Add This. A dialog box will open to 
confirm the operation. Click Yes to include the tag list of the current configuration to the tag list of 
the OPC Server. The name of the configuration will be added to the list of configurations. 
 
To add another configuration to the list, it is necessary to open the configuration in the SYSCON 
application and repeat this procedure. 
 
 

6.13.2 Removing a Configuration 
 
To remove a configuration from the consolidate list, select the name of the configuration in the 
Configurations list and click Remove. A dialog box will open to confirm the operation. Click Yes to 
remove the selected configuration from the tag list of the OPC Server. The name of the 
configuration will be removed from the list of configurations. 
 
 

6.13.3 Updating a Configuration 
 
If the tag list of a configuration that has been consolidated changes, it will be necessary to update 
the tag list of the OPC Server. 
 
Open the configuration file that had the tag list updated. Right-click the project icon and select the 
item Consolidate OPC Database to open the dialog box. 
 
Click the button Update This. A dialog box will open to confirm the operation. Click Yes to update 
the tag list in the OPC Server. 
 
 

NOTE 
This procedure has the same functionality of the Export Tags and Update OPC Database options, 
in the Export menu. 

 
 

6.13.4 Clearing the Consolidated List 
 
To reset the list of consolidated configurations and remove all of the tag lists from the OPC Server, 
open any configuration file in the SYSCON application. Right-click the project icon and select the 
item Consolidate OPC Database to open the dialog box. 
 
The list of configurations that have been consolidated will be displayed. 
 
Click the button Clear All. A dialog box will open to confirm the operation. Click Yes to reset the 
consolidated tag list of the OPC Server. 
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7.1 

7 Search Menu 
 
The user can search for devices and blocks on the project configuration. 
 
Go to the Search menu and click Find. See the following figure: 
 

 
Figure 7.1. Search Menu: Find 

 
The Find Tags dialog box will open: 
 

 
Figure 7.2. Find Tags Dialog Box 

 
To search for a device, click the Device tab, and type its tag on the Tag to Find text box, or select 
the tag on the Tags box. The device location will be shown on the Fieldbus Networks Location box. 
 
See the following example: 
 
1. Type the tag of the device. 

2. The Fieldbus Networks location will be indicated. 

 



SYSCON 6.0 - Users’ Manual 
 

7.2 

 
Figure 7.3. Searching for Devices 

 
3. Click Ok to open the Fieldbus window and locate the device. 
 
To search for a block, click the Block tab, and type its tag on the Tag to Find text box, or select the 
tag on the Tags box. The block location will be shown on the Fieldbus Networks Location box. The 
Physical Location box shows to which process cell and control module the block is attached. See 
the following example: 
 

 

Block Location 

 
Figure 7.4. Searching for Blocks 

 
Click Ok to open the Fieldbus window and localize the block. 
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8.1 

8 Properties 
 

8.1 Drawing Properties 
 
This section presents a brief explanation about the drawing properties. For example, the user can 
change the number of pixels that represents a logical measure unit, the background and the grid 
colors, or can choose a background image to be placed at the drawing area at the Strategy window. 
 
To change the drawing properties go to the Options menu and click Drawing Properties. Or activate 
the popup menu, right-clicking on the drawing area on the Strategy window. Click the item Drawing 
Properties. 
 

 
Figure 8.1. Options Menu: Drawing Properties 

 
The Drawing Properties dialog box will open: 
 

 
Figure 8.2. Drawing Properties Dialog Box 

 
The Apply button is used to apply the changes to the object, so the user can have a preview of how 
the changes affected it. 
 
Click Ok, the changes will be made and the dialog box will be closed. 
 
If the user clicks Cancel before clicking the Apply button, the changes will be lost. 
 
In each tab, different properties can be changed. They are explained in the following sections. 
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8.1.1 General Tab 

 
At the General tab, the user can change the drawing visualization and the total extents of the 
drawing. 
 

 
Figure 8.3. Drawing Properties Dialog Box: General Tab 

 
The Logical Units per Pixel Relationship rectangle defines: 
 
• How many X units will correspond to a determined number of pixels, increasing or decreasing 
 the numbers at the X boxes. This will increase the width view. 

• How many Y units will correspond to a determined number of pixels, increasing or decreasing 
 the numbers at the Y boxes. This will increase the height view. 
 
Selecting the Same X and Y Relationship box, any change done to the X variable, concerning the 
number of pixels that will represent a logical measure unit, will also be done automatically to the Y 
variable. This will maintain the correct proportion. 
 
At the Total Extents rectangle choose to represent the drawing: 
 
• In Units: the user will be working in a determined area independently from the paper size, 
 except when printing the drawing. In this case, the software will make a correspondence, 
 independent of the number of pages it will take. Increase or decrease the number of horizontal 
 and vertical units, typing or selecting a number at the X and Y boxes. 
 
• In Printable Pages: the drawing will be presented in a page format, according to the Print Setup 
 definitions and pre-defined Units size. Define how many side-by-side pages there will be at the 
 Horz box, and how many pages, one after the other vertically, there will be at the Vert box. 
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8.1.2 Colors Tab 

 
At the Colors tab, the user can change the background and the grid colors of the drawing area. 
 

 
Figure 8.4. Drawing Properties Dialog Box: Colors Tab 

 
At the Background rectangle, click the filled rectangle to select the background color. The Color box 
will open. Click the color at the palette and click OK. 
 
At the Grid rectangle, click the filled rectangle to select the grid color. The Color box will open. Click 
the color at the palette and click OK. 
 

8.1.3 Helper Tools Tab 
 
At the Helper Tools tab, the user can enable or disable gridlines, change the spacing between 
gridlines and type the zoom factor for the drawing view. 
 

 
Figure 8.5. Drawing Properties Dialog Box: Helper Tools Tab 
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At the first rectangle, select any of the three boxes: 
 
• Show Grid: select this box to show the grid points at the Strategy window drawing area. 

• Snap to Grid: select this box to make the objects snap to the grid. 

• Show Page Breaks: select this box to view horizontal and vertical page breaks according to the 
 number of horizontal and vertical pages determined when using the option In Printable Pages at 
 the General Tab. 

 
At the Grid Spacing rectangle define the space between gridlines, increasing or decreasing the 
number of units at the Units box. 
 
At the Zoom Factor rectangle define the zoom factor, typing the number that will determine how 
many times the drawing view will be increased or decreased. 
 

8.1.4 Background Image Tab 
 
At the Background Image tab, the user can choose any bitmap to be placed on the drawing 
background, defining its position or stretching it to the window size. 
 

 
Figure 8.6. Drawing Properties Dialog Box: Background Image Tab 

 
At the first rectangle, check the Select New Image box to choose a bitmap. 
 
The Open dialog box will open: 
 
1. In the Look in box, select the folder that contains the bitmap file to be added. 

2. Click on the bitmap file icon or type its name in the File name box. 

3. Click Open to conclude this task. 
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See the following figure: 
 

 
Figure 8.7. Open Image Dialog Box 

 
Check the Delete Current Image box to delete the bitmap currently used on the drawing. 
 
Check the Uses Transparency box to make one color of the bitmap transparent. Click the Color 
rectangle to open the palette and select a color. 
 
At the second rectangle, the user defines the view properties, such as placing image at a 
determined position, or stretching it to the window size. 
 
Select one of the options: 
 
• Center Image: places the bitmap at the center of the drawing area. 

• Stretch Image to Window Size: stretches the bitmap until it fits to the window size. 

• Stretch Window to Image Size: stretches the document window until it fits the bitmap. 

• Place Image At: defines a position for the bitmap inside the drawing area. To define the 
 horizontal position, type or select a value at the X: box. To define the vertical position, type or 
 select a value at the Y: box. 
 
At the Settings Above For: rectangle, the user can apply the bitmap position to the whole drawing 
area, checking the Whole Drawing box, or to each printable page, checking the Each Printable Page 
box. 
 

8.2 Object Properties 
 
This section presents a brief explanation about the object properties. For example, the user can 
change the position, the size, the line color, the fill color and the text attributes of a block drawn at 
the Strategy window. 
 
To change the properties of an object, select the object at the Strategy window, go to the Options 
menu and click Object Properties. Or activate the object menu, by right-clicking on it. Click the item 
Properties. 
 

 
Figure 8.8. Options Menu & Popup Menu: Object Properties 
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The Object Properties dialog box will open: 
 

 
Figure 8.9. Object Properties Dialog Box 

 
The Apply button will be used to apply the changes to the object, so the user can have a preview of 
how the changes affected it. 
 
Click Ok, the changes will be made and the dialog box will be closed. 
 
If the user clicks Cancel before clicking the Apply button, the changes will be lost. 
 
The Line, Fill and Text Attributes tabs have three additional buttons: 
 

 
 
• Inherit: this button turns back the default configuration. 

• Revert: this button turns back the anterior configuration. 

• Set As Default: this button makes the current configuration the default. 

 
Those buttons will be available when changing at least one object attribute. 
 
In each tab, different properties can be changed. They are explained in the following sections. 
 

8.2.1 General Tab 
 
At the General tab, the user can precisely change the position and the size of the selected object. 
The Status bar, at the bottom of the SYSCON window, displays information about the location of the 
cursor, while moving the cursor on the Strategy window. 
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Figure 8.10. Object Properties Dialog Box: General Tab 

 
At the Position rectangle define: 
 
• The horizontal position of the object, typing or selecting a number at the X box. 

• The vertical position of the object, typing or selecting a number at the Y box. 
 
At the Size rectangle define: 
 
• The width of the object, typing or selecting a number of horizontal units at the Width box. (The 
 minimum width is 75 units) 

• The height of the object, typing or selecting a number of vertical units at the Height box. (The 
 minimum height is 44 units) 
 

8.2.2 Line Tab 
 
At the Line tab, the user can change all line attributes of the selected object. 
 

 
Figure 8.11. Object Properties Dialog Box: Line Tab 

 
At the Thickness rectangle, the user can define the line thickness, typing or selecting a number. See 
the following examples of line thickness: 
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Thickness 1 Thickness 4
 

Figure 8.12. Line Thickness Examples 
 
At the Style rectangle, click the down arrow to select the line style. Choose a dashed line, a doted 
line, a dashed-dot line, a dashed-dot-dot line, or a solid line, which is the SYSCON default. See the 
following examples of line styles: 
 

Solid Line Dashed-Dot
Line  

Figure 8.13. Line Style Examples 
 
At the Color rectangle, click the filled rectangle to select the line color. The Color box will open. Click 
the color at the palette then click OK. See the following examples of line colors: 
 

Black Line Red Line
 

Figure 8.14. Line Color Examples 
 

8.2.3 Fill Tab 
 
At the Fill tab, the user can change all fill attributes of the selected object. 
 

 
Figure 8.15. Object Properties Dialog Box: Fill Tab 

 
Select one of the fill effects: Hollow, Solid or Hatched. 
 



Properties 
 

8.9 

The Style rectangle will be available when selecting the Hatched fill style. Choose a horizontal, a 
vertical, a f diagonal, a d diagonal, a cross, or a diagonal cross hatch. See the following examples of 
line styles: 
 

Hollow Solid F
Diagonal

Diagonal
Cross  

Figure 8.16. Fill Effects Examples 
 
The Color rectangle will be available for the Solid and Hatched fill style. Click the filled rectangle. 
The Color box will open. Click the color at the palette then click OK. See the following examples of 
fill colors: 
 

 
Figure 8.17. Fill Color Examples 

 

8.2.4 Text Attributes Tab 
 
At the Text Attributes tab, the user can change the text attributes of the selected object. 
 

 
Figure 8.18. Object Properties Dialog Box: Text Attributes Tab 

 
Select one of these options: 
 
• Full Quality: this option limits the text to work with Windows restricted attributes. The user won’t 
 be able to treat the text as if it were an object, resizing it any way or even changing its line or fill 
 attributes. 

• Fully Resizable: this option allows the user to modify any text attribute as if it were an object. 
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Choose the background style for the text: 
 
• Transparent: set a transparent background for the text. 

• Opaque: set a filled background for the text. 

 
The Background Color rectangle is available for the Opaque option. Click the color rectangle and 
the Color box will open. Choose the color and click Ok. See the following example: 
 

Transparent
Background

Opaque White
Background  

Figure 8.19. Background Style Examples 
 
The Font button opens the Font dialog box. The user can change the type, style, and size of the 
text. 
 
Choose the alignment of the text: click Left to align the text left; or click Center to align the text at the 
center; or click Right to align the text right. 
 
 
 



Section 9 
 

9.1 

9 Toolbars 
 
To activate a toolbar, go to the Tool menu and point to the item Tool Boxes. Click one of the 
toolbars shown on the list. A check mark appears next to the toolbar when it has been opened. 
 
The toolbars are placed at the left side of the SYSCON window. The user can drag the toolbar to 
any location in the window. 
 
The user can select the tools through the Tools menu and its submenus. When pointing the cursor 
on a submenu, a list of items will open, and the items have the same functionality as the toolbar 
buttons. The check will show the selected tool. 
 
 

9.1 Strategy Toolbar 
 
The Strategy toolbar will activate with the Strategy window. In case it’s not activated, go to the Tools 
menu, item Tool Boxes, and the option Strategy should be checked. 
 

 
Figure 9.1. Tools Menu: Strategy Toolbar 

 
The Strategy toolbar will open: 
 

 
Figure 9.2. Strategy Toolbar 

 
This toolbar has tools to create and manipulate new blocks, links and templates. 
 

 - Select Button 
 
Click this button to activate the Select tool. With this button clicked, it is possible to select any 
object(s) at the Strategy window for further operations, like moving, resizing etc. 
 

To select only one object at the Strategy window, click the Select button, , then click the object. 
 
With the Select button activated, the user has two options to select more than one object at the 
Strategy window. The first one is to press and hold down the Shift key, on the keyboard, while 
clicking each object to be selected. 
 
The second one is to click anywhere in the blank area of the Strategy window. While dragging the 
cursor, a box appears around the objects to be selected. 
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 - Strategy Modify Button 
 
Click this button to activate the Modify tool. This tool is used to change an object’s shape, as seen 
below: 
 

Original Ring Modified Ring
 

 
To use this tool, first select the object. After clicking the Modify button, click any Modify corner then, 
drag the cursor to obtain the new figure. See the following illustration: 
 

Modifying Corners

Cursor

Modified Ring
 

 

Use this tool to redraw a link. Use the Select Button, , on the Strategy toolbar, to select a link. 
The Modifying corners will appear. 
 
Click the link line to create a Modifying corner. Or right-click a Modifying corner to remove it from the 
link line. 
 

New Modifying
Corner

 
 
Click one corner and drag it onto the drawing area to redraw the link. 
 
If the current corner is set as the reference point, hold down the Ctrl key while dragging the corner to 
draw it at the same horizontal direction or at the same vertical direction. Or hold down the Shift key 
while dragging the corner to draw it at a diagonal direction. 
 
If the previous corner is set as the reference point, hold down the Ctrl key while dragging the corner 
to draw a horizontal or vertical line from the previous corner. Or hold down the Shift key while 
dragging the corner to draw a diagonal line from the previous corner. 
 
If the first corner is set as the reference point, hold down the Ctrl key while dragging the corner to 
draw a horizontal or vertical line from the next corner. Hold down the Shift key while dragging the 
first corner to draw a diagonal line from the next corner. 
 
See in the following figure the new link: 
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Also, use this button to modify a parameter label, a link label or a block label. 
 
Click the Modify button then click on the label to be changed. Type the new label then click the 
drawing area, or click another label to be changed. 
 
When a block label changes, the block tag will automatically be updated in the process cell window 
and in the Fieldbus window. The parameter label does not change in these windows. 
 

 - Function Block Button 
 
Click this button to create new function blocks. Just click the drawing area with this button selected 
and the New Block dialog box will open. Choose the block attributes and it will automatically draw 
after clicking the Ok button. 
 
See the section Creating New Blocks at the Strategy Window for further information. 
 

 - Link Button 
 
Click this button to create links between blocks. Click one of the blocks, choose the Output 
Parameter then, click another block, choosing the Input Parameter. 
 
See the section Creating a Link for further information. 
 

 - Import Strategy Template Button 
 
Click this button to add a template to the Strategy window. When clicking this button, the Open 
dialog box will appear. Select the file that contains the template and click Open. The template will 
automatically be added to the Strategy window. 
 
See the section Using Templates for further information. 
 

 - Export Selected Strategy as Template Button 
 
Click this button to create a template file. Select the blocks and links that will be part of the template, 
and select this button. The Save dialog box will open. Type a name for the template file and click 
Save. 
 
See the section Using Templates for further information. 
 

 - Forward Path Definition Button 
 
Allows defining the forward path definition of a given control strategy. Toggles the state of a given 
link. 
 

 - On Line Monitoring Button 
 
Click this button to put control strategy into the online mode. 
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9.2 Drawing Toolbar 
 
To activate the Drawing toolbar, go to the Tools menu, item Tool Boxes, and check the option 
Drawing. 
 

 
Figure 9.3. Tools Menu: Drawing Toolbar 

 
The Drawing toolbar will open: 
 

 
Figure 9.4. Drawing Toolbar 

 
This toolbar has tools to draw, manipulate, and format drawing objects. 
 

 - Select Button 
 
See the item Select Button at the Strategy toolbar section. 
 

 - Drawing Modify Button 
 
See the item Strategy Modify Button at the Strategy toolbar section. 
 

 - Rectangle Button 
 
Click this button to activate the Rectangle tool. To draw a rectangle, click the drawing area and drag 
the cursor diagonally in the direction desired, to obtain the desired figure. To draw a square, press 
and hold down the Shift key while dragging the cursor. See the figure: 
 

 
 

 - Rounded Rectangle Button 
 
Click this button to activate the Rounded Rectangle tool. To draw a rounded-corned rectangle, click 
the drawing area and drag the cursor diagonally in the desired direction, to obtain the desired figure. 
To draw a rounded-corned square, press and hold down the Shift key while dragging the cursor. 
See the figure: 
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 - Ellipse Button 
 
Click this button to activate the Ellipse tool. To draw an ellipse, click the drawing area and drag the 
cursor diagonally, to obtain the desired figure. To draw a perfect circle, press and hold down the 
Shift key while dragging the cursor. See the figure: 
 

 
 

 - Arc Button 
 
Click this button to activate the Arc tool. To draw an arc, click the drawing area and drag the cursor 
to obtain the desired figure. To draw an arc that has its height equal to its width, press and hold 
down the Shift key while dragging the cursor. See the figure: 
 

 
 

 - Pie Button 
 
Click this button to activate the Pie tool. To draw a pie, click the drawing area and drag the cursor to 
obtain the desired figure. To draw a pie that has its height equal to its width, press and hold down 
the Shift key while dragging the cursor. See the figure: 
 

 
 

 - Chord Button 
 
Click this button to activate the Chord tool. To draw a chord, click the drawing area and drag the 
cursor to obtain the desired figure. To draw a chord that has its height equal to its width, press and 
hold down the Shift key while dragging the cursor. See the figure: 
 

 
 

 - Ring Button 
 
Click this button to activate the Ring tool. To draw a ring, click the drawing area and drag the cursor 
to obtain the desired figure. To draw a ring that has its height equal to its width, press and hold 
down the Shift key while dragging the cursor. See the figure: 
 

 
 

 - Line Button 
 
Click this button to activate the Line tool. To draw a line, click the drawing area and drag the cursor 
to obtain the desired figure. To draw a perfectly horizontal or vertical line, press and hold down the 
Ctrl key while dragging the cursor. To draw a perfectly 45-degree diagonal line, press and hold 
down the Shift key while dragging the cursor. See the figure: 
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 - Pipe Button 
 
Click this button to activate the Pipe tool. To draw a pipe, click the drawing area and drag the cursor 
to obtain the desired figure. To draw a perfectly horizontal or vertical pipe, press and hold down the 
Ctrl key while dragging the cursor. To draw a perfectly 45-degree diagonal pipe, press and hold 
down the Shift key while dragging the cursor. See the figure: 
 

 
 

 - Polyline Button 
 
Click this button to activate the Polyline tool. To draw a polyline, drag the cursor and click at each 
corner to draw the lines. To draw a perfectly horizontal or vertical line, press and hold down the Ctrl 
key while dragging the cursor. To draw a perfectly 45-degree diagonal line, press and hold down the 
Shift key while dragging the cursor. To end a shape, right-click at any point. See the figure: 
 

 
 

 - Polygon Button 
 
Click this button to activate the Polygon tool. To draw a polygon, drag the cursor and click at each 
corner of the polygon. To draw a perfectly horizontal or vertical line, press and hold the Ctrl key 
down while dragging the cursor. To draw a perfectly 45-degree diagonal line, press and hold down 
the Shift key while dragging the cursor. To end a shape, right-click at any point. See the figure: 
 

 
 

 - Text Button 
 
Click this button to activate the Text tool. To type any text at the Strategy window, click at the 
drawing area and the cursor will change to a prompt. Type the text and click at the drawing area. 
 
 

 - Bitmap Button 
 
Click this button to import a bitmap file to the Strategy window. When clicking the drawing area with 
this button selected, the Open dialog box will appear. Select the bitmap file, clicking its icon or typing 
its name in the File name box, and click Open. 
 
Observe the following figure: 
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The bitmap will be added to the Strategy window and it has its own properties: right-click to activate 
its popup menu. 
 
See the following figure: 
 

Mouse Cursor

 
 
Check the item Uses Transparency to turn one color at the bitmap transparent. 
 
Click the item Set Transparent Color to choose one color that will be transparent in the bitmap. 
 
The item Change From File allows the user to select another bitmap to replace the current one. 
When clicking this item, the Open dialog box will appear. Select the folder that contains the new 
bitmap file, in the Look in box; click the file icon or type its name in the File name box and click 
Open. If the bitmap is not to be replaced, click Cancel. 
 
The item Save To File allows the user to save the bitmap as a .bmp file. When clicking this item, the 
Save As dialog box will appear. Choose the folder where the bitmap file will be saved, in the Look in 
box; type the file name in the File name box and click Save. If the bitmap is not to be saved, click 
Cancel. 
 
The item Properties will open the Object Properties dialog box. See the section Object Properties for 
further information. 
 
 

9.3 Alignment Toolbar 
 
To activate the Alignment toolbar, go to the Tools menu, item Tool Boxes, and check the option 
Alignment. 
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Figure 9.5. Tools Menu: Alignment Toolbar 

 
The Alignment toolbar will open: 
 

 
Figure 9.6. Alignment Toolbar 

 
This toolbar has tools to arrange (or distribute) drawing objects so they are equal distances from 
each other (vertically or horizontally), or they are aligned by their edges or centers (vertically or 
horizontally). 
 

 - Left Button 
 
Click this button to align the left side of the selected object(s) with the left side of the anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
 

Indication Cursor Aligned Blocks  
 

 - Center Button 
 
Click this button to align the horizontal center of the selected object(s) with the horizontal center of 
the anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
 

Indication Cursor Aligned Blocks
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 - Right Button 
 
Click this button to align the right side of the selected object(s) with the right side of the anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
 

Indication Cursor Aligned Blocks
 

 

 - Top Button 
 
Click this button to align the top of the selected object(s) with the top of the anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
 

Indication Cursor Aligned Blocks
 

 

 - Middle Button 
 
Click this button to align the vertical center of the selected object(s) with the vertical center of the 
anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
 

Indication Cursor Aligned Blocks
 

 

 - Bottom Button 
 
Click this button to align the bottom of the selected object(s) with the bottom of the anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
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Indication Cursor Aligned Blocks
 

 

 - Center Points Button 
 
Click this button to align the center of the selected object(s) with the center of the anchor. 
 
First, select the object (or objects) to be aligned. Then click the button and when the cursor is placed 
on the drawing area, it will change to an Indication cursor. Click the object that will be the anchor. 
See the figure: 
 

Indication Cursor Aligned Blocks
 

 

 - Evenly Spaced - Horizontal Button 
 
Click this button to distribute the selected objects horizontally, so there is equal horizontal distance 
between the edges of all the objects. This button works only for three or more objects. 
 
First, select all of the objects to be aligned, and then click the button. The objects will be promptly 
aligned. See the figure: 
 

Aligned BlocksSelected Blocks  
 
 

 - Evenly Spaced - Vertical Button 
 
Click this button to distribute the selected objects vertically, so there is equal vertical distance 
between the edges of all the objects. This button works only for three or more objects. 
 
First, select all of the objects to be aligned, and then click the button. The objects will be promptly 
aligned. See the figure: 
 

Aligned BlocksSelected Blocks
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9.4 Ordering Toolbar 
 
To activate the Ordering toolbar, go to the Tools menu, item Tool Boxes, and check the option 
Ordering. 
 

 
Figure 9.7. Tools Menu: Ordering Toolbar 

 
The Ordering toolbar will open: 

 
Figure 9.8. Ordering Toolbar 

 
This toolbar has tools to overlap as many drawing objects as desired and rearrange them in the 
stack. 
 

 - To Front Button 
 
Click this button to place the selected object in front of other overlapping objects. Select the object 
to be moved and click the button. See the figure: 
 

Selected Object After Ordering 
 

 

 - To Back Button 
 
Click this button to place the selected object behind other overlapping objects. Select the object to 
be moved and click the button. See the figure: 
 

Selected Object After Ordering  
 
 

 - Forward One Button 
 
Click this button to move the selected object one position forward in the stacking order. Select the 
object to be moved and click the button. See the figure: 
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Selected Object After Ordering
 

 

 - Backward One Button 
 
Click this button to move the selected object one position backward in the stacking order. Select the 
object to be moved and click the button. See the figure: 
 

Selected Object After Ordering  
 

 - Reverse Order Button 
 
Click this button to reverse the stacking order of two selected objects. To select two objects, click 
the first object. Hold the key Shift pressed and click the second object. Click the button and the 
stacking order will be reversed. See the figure: 
 

Selected Objects After Ordering
 

 

 - In Front Of Button 
 
Click this button to place the selected object in front of another object that will be the anchor. Select 
the object to be moved and click the button. When the cursor is placed in the drawing area, it will 
change to an Indication cursor with a plus sign, +. Click on the anchor object to conclude this task. 
See the figure: 
 

Selected Object After Ordering

+

Indication
Cursor  

 
 

 - Behind Button 
 
Click this button to place the selected object behind another object that will be the anchor. Select the 
object to be moved and click the button. When the cursor is placed in the drawing area, it will 
change to an Indication cursor with a minus sign, -. Click on the anchor object to conclude this task. 
See the figure: 
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Selected Object After Ordering

-

Indication
Cursor  

 

9.5 Copy Attributes Toolbar 
 
To activate the Copy Attributes toolbar, go to the Tools menu, item Tool Boxes, and check the 
option Copy Attributes. 
 

 
Figure 9.9. Tools Menu: Copy Attributes Toolbar 

 
The Copy Attributes toolbar will open: 
 

 
Figure 9.10. Copy Attributes Toolbar 

 
This toolbar has tools that make an object(s) appearance equal to another object. 
 

 - Same Width Button 
 
Click this button to copy the width from one object to another. Select the object that will have its 
width changed, and click the button. The cursor will change to an Indication cursor. Click the anchor 
object to copy its width and conclude this task. See the figure: 
 

After Copying Width
Indication Cursor  

 

 - Same Height Button 
 
Click this button to copy the height from one object to another. Select the object that will have its 
height changed, and click the button. The cursor will change to an Indication cursor. Click the 
anchor object to copy its height and conclude this task. See the figure: 
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After Copying HeightIndication Cursor  
 

 - Same Dimensions Button 
 
Click this button to copy the width and the height from one object to another. Select the object that 
will have its dimensions changed, and click the button. The cursor will change to an Indication 
cursor. Click the anchor object to copy its dimensions and conclude this task. See the figure: 
 

After Copying DimensionsIndication Cursor
 

 

 - Same Pen & Brush Button 
 
Click this button to copy the line and the fill color from one object to another. Select the object that 
will have its colors changed, and click the button. The cursor will change to an Indication cursor. 
Click the anchor object to copy its colors and conclude this task. See the figure: 
 

After Copying Line and
Fill ColorsIndication Cursor

 
 

 - Same Font & Colors Button 
 
Click this button to copy the text font and colors from one object to another. Select the object that 
will have its font and color changed, and click the button. The cursor will change to an Indication 
cursor. Click the anchor object to copy its colors and conclude this task. See the figure: 
 

After Copying Text Font
and ColorsIndication Cursor  

 

 - Same Text Attributes Button 
 
Click this button to copy the text font, size and colors, from one object to another. Select the object 
that will have its text attributes changed, and click the button. The cursor will change to an Indication 
cursor. Click the anchor object to copy its colors and conclude this task. See the figure: 
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After Copying Text
AttributesIndication Cursor  

 

 - Set Attributes As Default Ones Button 
 
Click this button to set the objects attributes as default. Select the object that will have its attributes 
set as default and click the button. The objects will be drawn with the same line color, fill color, text 
font and text size as the object selected. 
 
 

9.6 Characterization Toolbar 
 
The Characterization toolbar is displayed in the Block Characterization dialog box. 
 

 
Figure 9.11. Characterization Toolbar 

 

 - Input Button 
 
Click this button to display the input parameters of the block. An input parameter obtains its value 
from a source external to the block. 
 

 - Output Button 
 
Click this button to display the output parameters of the block. An output parameter is a parameter 
that may be linked to an input parameter of another block. 
 

 - Contained Button 
 
Click this button to display the contained parameters of the block. A contained parameter is a 
parameter whose value is configured, set by an operator, higher-level device or calculated. 
 

 - Dynamic Button 
 
Click this button to display the dynamic parameters of the block. Dynamic parameter values are 
calculated by the block algorithm and therefore do not need to be restored after a power failure. 
 

 - Diagnostic Button 
 
Click this button to display the diagnostic parameters of the block. 
 

 - Service Button 
 
Click this button to display the service parameters of the block. 
 

 - Operate Button 
 
Click this button to display the operate parameters of the block. 
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 - Alarm Button 
 
Click this button to display the alarm parameters of the block. Alarms and events, known as alerts, 
represent state changes within function block applications. 
 

 - Tune Button 
 
Click this button to display the tune parameters of the block. 
 

 - Local Button 
 
Click this button to display the local parameters of the block. 
 

 - Confirmed Edition Button 
 
If this button is highlighted, the user will change the parameter value then click the End Edit button 
at the bottom of the Characterization window, or press the Enter key on the keyboard, to confirm the 
edition and accept the changes. 
 
If this button is not highlighted, the user will change the parameter value then click the End Edit 
button at the bottom of the Characterization window, press the Enter key on the keyboard, or click 
on another parameter line, to confirm the edition and accept the changes. 
 

 - Column Relative Index Button 
 
Click this button to display the Relative Index column. 
 

 - Column Handling Button 
 
Click this button to display the Handling column. 
 

 - Customization Buttons 
 
Click one of these buttons to display the parameter for the block according to the user customization 
– by Block Type or Block Tag. See the section Customize Characterization for further details. 
 

 - Mark to Save Button 
 
This button is only available in the On Line Characterization Toolbar. Click this button to mark a 
parameter value and save it even if it wasn't edited, or to unmark a parameter that changed the 
value but the changes are not to be saved. See the section Block On Line Characterization for 
further details. 
 

 - Show Value as Symbol Button 
 
Click this button to display the parameter value as a symbol or as a numeric value. 
 

 - DD Help Button 
 
Click this button to display the DD’s help information about the parameter at the bottom of the 
Characterization window. 
 
 



Toolbars 
 

9.17 

 

9.7 General Operation Toolbar 
 
The General Operation toolbar is automatically activated with SYSCON. It is placed under the Main 
menu. 
 

 
Figure 9.12. General Operation Toolbar 

 

 - New Button 
 
Click this button to create a project file. See the section New Project. 
 

 - Open Button 
 
Click this button to open a project file. See the section Open. 
 

 - Save Button 
 
Click this button to save the project or any of its parts, such as the process cell window or the 
Strategy window. See the section Save. 
 

 - Save All Button 
 
Click this button to save the entire plant project configuration. See the section Save Entire 
Configuration. 
 

 - Cut Button 
 
Click this button to remove the selection from the project and place it on the clipboard. 
 

 - Copy Button 
 
Click this button to copy the selection to the clipboard. 
 

 - Paste Button 
 
Click this button to insert the contents of the clipboard at the insertion point. This command is 
available only if the user has cut or copied an object. 
 

 - Print Button 
 
Click this button to print the project configuration or the drawing objects at the Strategy window. See 
the section Printing the Project Configuration. 
 

 - Print Preview Button 
 
Click this button to see how the project will be printed. The user can change the printer configuration 
and select the objects to be printed. See the section Print Preview. 
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 - Operation Mode Button 
 
Click this button to toggle between operation modes. If the button is clicked, SYSCON is operating 
in the On Line mode. Otherwise, it’s in the Off Line mode. 
 

 - Error Log Button 
 
Click this button to open the Error Log window. The Error Log window reports the errors that 
occurred during the communication. 
 

 - Show/Hide Button 
 
Click this button to show or hide detailed information about blocks types, blocks parameters, devices 
types and fieldbus macrocycle. 
 

 - Contents Button 
 
Click this button to open the SYSCON Help Contents. 
 
 
 



Section 10 
 

10.1 

10 Device Support 
 

10.1 Including New DD and Capabilities File 
 
The Device Description for a particular device is provided by the device‘s manufacturer and 
distributed by Fieldbus Foundation. If it is not currently available from the Fieldbus Foundation, the 
user may need to contact the manufacturer and get a copy of the DD. 
 
There is a DD for each device type, and it consists of the files whose extensions are “.ffo” and 
“.sym”. 
 
The Capabilities File is used to define the device capabilities – e.g., dynamic block instantiation 
capability - and the resources available for creating Function Block Applications, Resource Blocks, 
Transducer Blocks, and Function Blocks. 
 
The Capabilities File consists of the files whit the extension “.cff”, and they are placed together with 
the DD files. 
 
The files are organized in the manufacturers’ folder as the following figure shows: 
 

 
Figure 10.1. Device Support Folders 

 
SYSCON needs DD and Capabilities Files in order to configure a device. 
 
Follow the steps below to add a new DD and Capabilities File to SYSCON: 
 
1. Go to the Device Support installation folder. 

2. Inside the Device Support folder, create a new folder for the manufacturer, if it is not yet there. 

3. The folder name should be a 6 hexadecimal digits manufacturer’s code, e.g., 000302 for SMAR. 

4. Inside the manufacturer’s folder, create the Device Type folder. 

5. The name for this folder should be the 4 hexadecimal digits of the Device Type code, e.g., 0001 
 for the LD302. 

6. Copy the DD and the Capabilities Files for the new device from the corresponding folder to the 
 newly created manufacturer and Device Type folders, inside the Device Support folder. 
 
After that, SYSCON will be able to reference the new DDs in the dialog boxes for creation of device 
and blocks, showing the Manufacturer ID and the Device Type code. 
 
However, SYSCON will not be able to show the manufacturer name or the device name. To show 
those names on SYSCON, the user must define them in the “Device Support.ini“ file. See the 
section Defining Manufacturers and Device names. 
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If the device supports dynamic instantiation of function blocks, the user must define the Function 
Block Mnemonics. See the section Defining a Block Mnemonic. 
 
If the Capabilities File is not provided, the user can define it since the necessary information is 
available. See the section Creating a new Capabilities File. 
 
 

10.2 Defining Manufacturers and Device Names 
 
The file “Device Support.ini” in the folder Device Support maintains all definitions for the 
manufacturers’ and device's names. The user may need to add definitions. 
 
SYSCON gives the user the opportunity to define manufacturers’ and devices' names in order to 
show them in the dialog boxes when adding new device or new blocks to the Fieldbus 
Configuration. 
 
Follow the steps below to add new definitions: 
 
1. Open the “Device Support.ini” file. 

2. Create the new manufacturer in the [Manufacturers By Id] section. 
 

The definition of the name for a particular manufacturer has the following format: 
 

<manufacturer_id> = <manufacturer_name> 

where 

“manufacturer_id“ is the 6 hexadecimal digits manufacturer’s code; 
“manufacturer_name“ is the manufacturer’s name that will appear in the dialog boxes. 
 
Example: 

[Manufacturers By Id] 
000302=Smar 

 
3. Create a section to maintain the new manufacturer’s devices. 
 

The definition of the section for a particular manufacturer has the following format: 
 

[<manufacturer_id> Devices By Code] 

where 

“manufacturer_id“ is the 6 hexadecimal digits manufacturer’s code. 
 
Example: 

[000302 Devices By Code] 
 
4. Define the devices' names in this new section. 
 

The definition of the name for a particular device has the following format: 
 

<device_type_code>=<device_name> 

where 

“device_type_code“ is the 4 hexadecimal digits of the Device Type code; 
“device_name” is the device's name that will appear in the dialog boxes. 
 
Example: 

0001=LD 302 
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10.3 Creating a new Capabilities File 
 
If the Capabilities File is not provided, it can still be defined since the user already has the 
necessary information. 
 
The source of information may be the Device Manufacturer, the device itself or the old “.ini “ or “.drf 
“ Resource Files. 
 
Follow these steps to define a Capabilities File: 

1. Copy the template file “Capabilities.cff” at the SYSCON folder. 

2. Go to the Device Support installation folder and paste it in the device folder corresponding to the 
 device being created in the Capabilities File. 

3. Rename the file to match the corresponding DD files. 

4. Edit the template file and provide all of the necessary information. 

5. If the device supports dynamic instantiation of Function Blocks, the Function Block Mnemonics 
 will still have to be defined in the file “Device Support.ini”. 

 
If there is any Block Mnemonic missing, then add its definition to the “Device Support.ini” file. See 
the section Defining a Block Mnemonic. 
 

10.4 Defining a Block Mnemonic 
 
When defining a Capabilities File for a device that can dynamically create instances of function 
blocks, the user must create a section for each one of these blocks in the “.cff “ file. 
 
The Function Block Mnemonic names those sections. Therefore, the user should define each of the 
Function Blocks Mnemonics, so that SYSCON can identify the blocks. 
 
Blocks Mnemonics are defined in the file “Device Support.ini”, located in the Device Support folder, 
in a section named “[Block Type Mnemonics]”. 
 
Inside this section, the definition of the mnemonic for a particular function block has the following 
format: 
 

[Block Type Mnemonics] 
<m_id> <d_type> <d_revision> <dd_revision> <block_dditemid>=<block_mnemonic> 

 
where: 

<m_id> is the 6 hexadecimal digits manufacturer’s code; 
<d_type> is the 4 hexadecimal digits of the Device Type; 
<d_revision> is the Device Revision; 
<dd_revision> is the DD Revision; 
<block_dditemid> is the DDItemId; 
<block_mnemonic> is the mnemonic for the block. 

 
Example: 
 

[Block Type Mnemonics] 
000302 0001 01 02 800202B0=PID 

 
where: 

000302 is the SMAR manufacturer code; 
0001 is LD302 Device Type code; 
01 is the Device Revision; 
02 is the DD Revision; 
800202B0 is the DDItemId for the Block PID. 

 
Just follow this pattern to add new definitions. 
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10.5 Importing Device Support Files 
 
SYSCON can automatically import the DD and CF files of a device. 
 

IMPORTANT 
The user must be logged on as an Administrator or a member of the Administrators group to 
import the DD and CF files. 

 
 
On the Project File menu, click Import Device Support: 
 

 
Figure 10.2. Importing the Device Support Files 

 
The Browse dialog box will open. Select the directory where the DDs and CFs of the device being 
imported are located and click Ok. 
 
The Import Device Support dialog box will open showing the list of files that will be imported in the 
Device Support folder of the correspondent manufacturer: 
 

 
Figure 10.3. Confirming the Files to be Imported 
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Click Ok and a message box will appear informing the user that the operation was successful. 
 

 
Figure 10.4. Importing Device Support Files 

 
Click Ok to conclude. 
 
 

10.6 Checking Missing Device Support Files 
 
Everytime the user opens a configuration, SYSCON will verify if the DDs and Capabilities Files used 
in the configuration are installed with the application. 
 
A message box will open informing the user if one or more files are missing: 
 

 
Figure 10.5. Checking Missing Device Support Files 

 
In this dialog box, click Yes to open the Locate Missing Device Support Files dialog box: 
 

 
Figure 10.6. Locate Missing Device Support Files Dialog Box 

 
 

NOTE 
If the user clicks No, SYSCON will load the configuration but some blocks and parameters will not 
be available. 

 
 
The following sections will describe the steps to locate the missing files. 
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10.6.1 Locating the Files Manually 
 

IMPORTANT 
The user must be logged on as an Administrator or a member of the Administrators group to copy 
the DD and CF files to the Device Support. 

 
In the Locate Missing Device Support Files dialog box, right-click the icon of the missing file and 
select the option Locate in the menu: 
 

 
Figure 10.7. Locating the Files Manually 

 
The Browse dialog box will open. Browse the directories to select the folder that contains the DD 
and CF files: 
 

 
Figure 10.8. Searching the Files 

 
Click Ok. SYSCON will automatically create the device's folder copying the DDs and CFs. 
 
Repeat these steps for each file listed in the Locate Missing Device Support Files dialog box. 
 
After locating the files, click Close to return to the application and open the configuration file. 
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10.6.2 Generating the DSM File 
 

IMPORTANT 
The user must be logged on as an Administrator or a member of the Administrators group to 
create the DSM file and then import the DD and CF files to the Device Support. 

 
 
In the Locate Missing Device Support Files dialog box, click the button Generate DSM to create the 
DSM file. The Device Support Maintenance file has the list with of the files that are missing in the 
configuration. 
 
Clicking the button Generate DSM will open the Browse dialog box. Browse the directories to select 
the folder where the DSM file will be saved: 
 

 
Figure 10.9. Creating the DSM file 

 
Click Ok. A message box will appear informing the user that the operation was successful. 
 

 
Figure 10.10. Operation Completed 

 
Click Ok to return to the Locate Missing Device Support Files dialog box. 
 
The DSM file should be sent to a machine that has the missing DDs and CFs, usually the machine 
where the configuration was originally created. See section 10.6.3 
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Packing the Missing Device Support Files. 
 
The user will receive the package with the DD and CF files in the folder Missing Files, and then will 
import these files. 
 
In the Locate Missing Device Support Files dialog box, click the button Import DSM: 
 

 
Figure 10.11. Copying Missing Device Support Files 

 
The Open dialog box will appear. Browse the directories to locate the folder Missing Files, and then 
select the DSM file: 
 

 
Figure 10.12. Selecting the DSM File 

 
Click Open and a message box will appear informing the user that the operation was successful. 
Click Ok: 
 

 
Figure 10.13. Operation Completed 

 
Click Close in the Locate Missing Device Support Files dialog box to return to the application and 
open the configuration file. 
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10.6.3 Packing the Missing Device Support Files 
 

IMPORTANT 
The user must be logged on as an Administrator or a member of the Administrators group to 
create the package with the DD and CF files. 

 
To create a package with the missing files, it is necessary to send the DSM file generated in the 
machine where the DD and CF files are missing, to the machine that has the proper Device Support 
directory. 
 
Using SYSCON, go to the Project File menu and click Pack Missing Device Support: 
 

 
Figure 10.14. Packing Missing Device Support Files 

 
The Open dialog box will appear. Browse the directories to locate the DSM file. Select the file icon 
and then click Open: 
 

 
Figure 10.15. Selecting the DSM File 

 
The Browse dialog box will open. Select the folder where the package with the missing files will be 
created and click Ok. 
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Figure 10.16. Creating the package with the missing files 

 
A message box will appear informing the user that the operation was successful and the folder 
Missing Files was created. 
 

 
Figure 10.17. Operation Completed 

 
Click Ok to conclude. 
 
The folder Missing Files should be sent to the machine where the DDs and CFs are missing. 
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11 Troubleshoot 
 
1. Version Mismatch  
Converting from an older configuration version.  
For discarding, close without saving.  
 
This is a message, not an exception. It means that the user is trying to open a configuration file, 
which was generated in an older version of the tool that had an old-fashioned file format. If the user 
accepts to upgrade, the configuration is going to be converted to the new file format and the user 
won't be able to open the configuration in a version of the tool, which supports the old file format 
again. This message is only issued by SYSCON from version 5.10 on. 
 
 
2. Version Mismatch  
Unable to open a newer configuration version.  
 
This is a message, not an exception. It means that the user is trying to open a configuration file, 
which was generated in an earlier version of the tool that has a new file format. SYSCON cannot 
perform configuration downgrade. This message is only issued by SYSCON from version 5.10 on. 
 
 
3. DD Exception  
Standard Dictionary Not Found!  
 
This means that the Standard.dct file is missing in the Device Support and can generally happen 
because of problems during the system installation. 
 
 
4. FF Exception  
Block with Profile 0x#### and Profile Revision 0x#### could not be found.  
DD and CF: ######\####\####(##).  
DDItem = 0x########  
 
This happens because some block type could not be recognized. It means there were problems with 
DDs or CFs installation. During the opening of a configuration file it has a special meaning, and it 
can easily be identified by the null Profile and Profile Revision numbers. In this case SYSCON is 
trying to upgrade a configuration generated with an old version of SYSCON (4.x or earlier) that 
didn't work - therefore did not retain the numbers. During the configuration file upgrade, SYSCON 
tries to get the Profile and Profile Revision for the blocks in the configuration by searching the CF 
given the DDItemID for the block. This FF exception occurs because the CF is not present or, in 
case the CF exists, the exception occurs because the CF might be inconsistent. It is very common 
when a configuration is generated in one machine and moved to another one that maintains a 
different set of DDs and CFs from the original machine. The DD and CF information in the message 
identifies which CF file has been searched. 
 
 
5. Maximum number of Blocks has been exceeded.  
License Violation  
 
It means that the user is trying to open a configuration that has more blocks than the SYSCON 
license allows. This usually happens when the project file has been generated with a SYSCON 
version that supports the number of blocks configured in the project, but the user is trying to open 
the project with another SYSCON version with a license that allows less blocks than has been 
configured in the project file. 
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6. DD Not Found 
 
If SYSCON tries to use a DD file that is missing or corrupted, the Device Description Error message 
will be sent to the user through the Error Log window. This message indicates the DD file that is 
missing or corrupted and reports the details about the error. 
 
There is one situation that a missing DD will stop the application. When a configuration file is 
generated with SYSCON version 4.x, or previous versions, and the user attempts to open the file 
with SYSCON version 5.20, the application will generate an exception indicating the information that 
is missing and will abort after the user acknowledgement. 
 
 
7. The HSE port of the DFI has address 0  
 
This problem may occur when: 
 
• The address wasn’t read because the bridge was not found in the Live List. 

• The bridge was not in the Live List during the Init Communication. 
 
These conditions mean that the problem occurs rarely. If it occurs, it will be necessary to terminate 
the communication and restart it. 
 
 
8. Multilink Topology Request 
 
This dialog box will open when SYSCON tries to re-initialize the communication after an event 
occurs, for example, when the bridge stop communicating for a moment and then return to normal 
operation. 
 
 
9. Converting the HSE configuration from SYSCON version 5.2x to version 6.x 
 
Follow the steps below to convert an HSE project configured in SYSCON version 5.2x to SYSCON 
version 6.x: 
 
a) Open the HSE configuration in SYSCON version 6.x; 

b) Disconnect all bridges from the HSE fieldbus, right-clicking each bridge and selecting 
 Disconnect from; 

c) Remove the HSE fieldbus, right-clicking the fieldbus icon and selecting Delete; 

d) Add a new HSE fieldbus, right-clicking the fieldbus networks icon and selecting New Fieldbus. 
 The New Fieldbus dialog box will open. Select the HSE type, edit the fieldbus tag and click Ok; 

e) Connect all bridges to the HSE fieldbus, right-clicking each bridge and selecting Connect to. 
 The Connect to dialog box will open. Select the HSE network and click Ok. 
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Step-by-Step Configuration 
 
SYSCON let the user starts the project configuration from the Process Control or from the Fieldbus. 
 
The user can start the configuration with the Process Control and import templates files to the 
Strategy window, easily adding blocks to the project. 
 
This example will start the configuration from the Fieldbus, using the Analog Input, the PID Control 
and the Analog Output blocks to build the following Cascade Control configuration: 
 

 

 

 
 

Creating the Project File 
 

To create a new Fieldbus project, click the New button, , on the General Operation toolbar. The 
Document Type box will open. Click the option Projects, as indicated below: 
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The New Project dialog box will open: 
 

 
 
Type the name for the new project at the File Name box, and then click Save. The Project window 
will open. 
 

 
 
 

Starting with the Fieldbus Configuration 
 
In the Project window, right-click the Fieldbus Networks icon and click the item New Fieldbus. The 
New Fieldbus dialog box will open. Select the communication port for the fieldbus, type the tag 
Fieldbus 1 and click Ok. 
 

 
 
Double-click the Fieldbus 1 icon to open its window. To organize the screen view, go to the Window 
menu and click Tile. 
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Adding the Devices 

 
Now add the devices that will be used in this project. 
 
First, add the Smar Temperature Transmitter – TT302. 
 
In the Fieldbus 1 window, right-click the Fieldbus1 icon. Click the item New > Device. The Device 
dialog box will open: 
 
1. Select Smar in the Device Manufacture box. 

2. Select the TT302 Device in the Device Type box. 

3. Type the tag Temperature in the Device Tag box. 

4. Click OK. 
 

 
 
Follow the same procedure to add the Smar Flow Transmitter – LD302 with the tag Flow, and the 
Smar Flow Valve Controller – FP302 with the tag FlowValve. 
 
After finishing this process, the Fieldbus 1 window should look like the following figure: 
 

 
 

Adding Blocks 
 
When a new device is added to the filedbus channel, the Transducer, Resource and Display blocks 
are automatically created for the device. 
 
It will be necessary to add the blocks that will be used in the process control. 
 
To add a new block, click the device expansion sign, , select the FB icon and right-click it. Click 
the item New Block. 
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The New Block dialog box will open. Add the first block: 
 
1. Select Analog Input in the Block Type box. 

2. Type the tag TT100_AI in the Block Tag box. 

3. Click OK. 

 
 
Repeat the procedure from above to add the following blocks: 
 

Device Block Type Block Tag 

Temperature PID Control TIC100_PID 

Analog Input FT101_AI 
Flow 

PID Control FIC101_PID 

Flow Valve Analog Output FCV102_AO 
 
The Fieldbus window should look like the following figure: 
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Remember to save the project. 
 
 

Continuing with the Process Control Configuration 
 
Create the process cell. Right-click the area icon and select the item New Process Cell. 
 

 
 
Type the tag Process Cell 1 and click OK. 
 
Double-click the Process Cell 1 icon to open its window. 
 
To create a control module, select the process cell icon, on the Process Cell window, and right-click 
it. Click the item New Control Module. 
 

 
 
Type the tag Control Module 1 and click OK. 
 
 

Attaching blocks to the control module 
 
The next step will be to attach the blocks, from the devices to the control module. 
 
Open the Fieldbus window and the Process Cell window. Arrange these windows side by side by 
clicking the item Tile at the Window menu. 
 
In the Fieldbus window, click the block that will be attached and drag it to the Process Cell window, 
on the control module icon. 
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The block will be attached to the control module. 
 
Repeat this operation to attach the blocks TIC100_PID, FT101_AI, FIC101_PID and FCV102_AO to 
the control module. See the figure below: 
 

 
 
When all of the blocks are attached, the user will have to drag the blocks to the Strategy window to 
start the design configuration. 
 
 

Creating the Strategy 
 
Now make the strategy configuration. Double-click the control module icon to open the Strategy 
window. 
 
Organize the Strategy and the Process Cell windows clicking the item Tile at the Window menu. 
 
Drag the blocks from the control module to the Strategy window: 
 
1. Click and hold the TT100_AI block icon, . 

2. Drag it into the Strategy window. 
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The block will automatically be drawn. 
 
Repeat the procedure and drag the other blocks to the Strategy window, trying to position them 
according to the project design in the beginning of this appendix. See the following figure: 
 

 
 

NOTE 
If the block is dropped too close to one already added to the Strategy window, the block will not 
be drawn. It will be necessary to move the blocks in order to organize the project, after they have 
been dropped in the Strategy window. 

 
Remember that it is possible to change the blocks attributes and select different colors for each 
block. Right-click the block in the Strategy window and select the option Properties. 
 
 

Linking Blocks 
 
First, link the OUT Parameter of the TT100_AI block to the IN Parameter of the TIC100_PID block: 
 

1. Click the Link button, , on the Strategy toolbar. 

2. Right-click the block TT100_AI. 

3. Click OUT in the popup menu. 
 

 
 



SYSCON 6.0 - Users’ Manual 
 

A.8 

4. Drag the cursor to the block TIC100_PID. 

5. Right-click the block. 

6. Select IN from the Parameters List. 
 

 
 
The linking process is complete. 
 

 
 
Follow the steps above to link the OUT Parameter of the TIC100_PID block to the CAS_IN 
Parameter of the FIC101_PID block. 
 

 
 
Repeat the process and link the OUT Parameter of the FT101_AI block to the IN Parameter of the 
FIC101_PID block. 
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Then, link the OUT Parameter of the FIC101_PID block to the CAS_IN Parameter of the 
FCV102_AO block. The Strategy window should look like the following figure: 
 

 
 
 

Creating the feedback link 
 
To create the Feedback Link between FIC101_PID and TIC100_PID, follow these steps: 
 
1. Right-click on the FIC101_PID block. 

2. Select BKCAL_OUT from the Parameters List. 

3. Drag the cursor diagonally to the left side of the middle. 

4. Click on the drawing area. 

5. Continue dragging the cursor vertically until the Link line is near the TIC100_PID block. 

6. Click on the drawing area. 

7. Drag the Link line horizontally until it reaches the TIC100_PID block. 



SYSCON 6.0 - Users’ Manual 
 

A.10 

 

 
 
To conclude the Link: 
 
8. Right-click on the TIC100_PID block. 

9. Select BKCAL_IN from the Parameters List. 
 
The design configuration should look like the following figure: 
 

 
 
Follow these steps above to link the BKCAL_OUT Parameter of the FCV102_AO block to the 
BKCAL_IN Parameter of the FIC101_PID block. 
 
At the end of the linking process, the Strategy window should look like the following figure: 
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Click the button Save Entire Configuration, , to save the project. 
 
 

Block Off Line Characterization 
 
Parameterize the TT100_AI block. Double-click the block in the Process Cell window or Fieldbus 
window. The Block Characterization dialog box will open: 
 

 
 
Click the expansion sign, , in front of the MODE_BLK parameter. Select the element TARGET 
and click Edit. 
 
Select the mode Auto from the list by checking its box. Click End Edit. 
 
To exit the Block Characterization dialog box click the Close button. 
 
Repeat this procedure to characterize the other blocks. The following table specifies the parameters 
and its elements: 
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Block Parameter Element Mode 

MODE_BLK TARGET Auto 

EU_100 600 

EU_0 0 PV_SCALE 

UNITS_INDEX °C 

EU_100 200 

EU_0 0 

TIC100_PID 

OUT_SCALE 

UNITS_INDEX kg/h 

MODE_BLK TARGET Auto 

EU_100 200 

EU_0 0 XD_SCALE 

UNITS_INDEX inH2O (4o C) 

EU_100 200 

EU_0 0 OUT_SCALE 

UNITS_INDEX kg/h 

FT101_AI 

L_TYPE  Indirect Sq Root 

MODE_BLK TARGET Cas 

EU_100 200 

EU_0 0 PV_SCALE 

UNITS_INDEX kg/h 

EU_100 100 

EU_0 0 

FIC101_PID 

OUT_SCALE 

UNITS_INDEX % 

MODE_BLK TARGET Cas 

EU_100 100 

EU_0 0 PV_SCALE 

UNITS_INDEX % 

EU_100 15 

EU_0 3 

FCV102_AO 

XD_SCALE 

UNITS_INDEX psi 
 
Remember to save the project file. 
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